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Getting Started

System Requirements
To use the Eudora Light electronic mail (e-mail) application (hereafter referred to as Eudora), you
must have the following:

IBM PC or compatible.

Microsoft Windows 3.1 for 16-bit version; Microsoft Windows 95 or Windows NT 3.51 or later
for 32-bit version.

Winsock 1.1 API compliant networking package (not needed for serial connection).

A mail account with an Internet Service Provider or an Internet-style network.

Access to your mail account via a modem (9600 bps or higher recommended) or Internet-style
network connection.

Installing Eudora
Installing Eudora is simple, and requires very little input—just follow the instructions below. If you
are installing over a previous version of Eudora Light, all of your  messages, mailboxes, folders, and
options will be maintained.

To install Eudora,  do the following:

1. Exit any applications you are running including toolbars, memory management programs,
screen savers, and virus protection programs.

2. If you are installing from a software archive, double-click on it to start the Setup application.

If you are installing from diskette, insert the Eudora diskette 1 into drive A: of your PC. Then
select Run... from the Start menu, enter A:Setup.exe, and click OK.

3. Read the Welcome screen, then click Next. The Software License Agreement is displayed.

4. Read the Software License Agreement and click Yes.

6. Specify a directory to install Eudora Pro, then click Next.

Note: If you are already using Eudora, you can select your current Eudora directory
and all of your  messages, mailboxes, folders, and options will be maintained.

7. Select the version of the software that you want to install, 16- or 32-bit.

Based on the operating system and connectivity software that you are running, the Setup
program recommends an appropriate version. The 32-bit software can be used with the 32-bit
operating systems Windows 95 or Windows NT 3.51 or later, but it also requires 32-bit
connectivity software. If you are using a 32-bit operating system but the Setup program
recommends the 16-bit version, it is probably because your connectivity software is 16-bit.

8. Verify that the displayed settings are correct, then click Next (or use the Back button if you need
to go back and make changes).

9. If you are installing from diskette, you are prompted to insert the additional diskettes into drive
A.

10. Eudora is installed in the destination directory, and you are prompted for whether or not you
want to view the README file. Click Yes.
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Uninstalling Eudora
You can uninstall Eudora by using the tools provided with your Windows operating system. In
Windows 95 or Windows NT 4.0, open the control panel, double-click on Add/Remove Programs,
select Eudora, and click Remove. In Windows 3.1 or Windows NT 3.5, open the Eudora program
group from within the Program Manager, then double-click on the Uninstall Eudora icon.

Opening and Configuring Eudora
After you have installed Eudora, double-click on its icon to open it. If you are installing Eudora for
the first time, the Getting Started Options are displayed.

To send and receive messages, you must have an account on a computer running a POP (Post Office
Protocol) server, and access to a computer running an SMTP (Simple Mail Transfer Protocol) server.
Your incoming e-mail messages are delivered to your POP account, where Eudora picks them up and
transfers them to your PC. Your outgoing messages are sent to the SMTP server, which delivers
them to your recipients.

You have to provide basic information about your account, servers, and network connection before
you can send and receive messages. To do this, use the Getting Started Options (if this is not open,
select Options... from the Tools menu and click on the Getting Started category).

An example of Getting Started Options

In the POP account field, type your POP account name, an “@” sign, and the full name of the
computer that is running the POP server. For example, if your assigned POP account name is
“jcorrea,” and the name of the computer where you receive e-mail is “pop3.qualcomm.com” type
“jcorrea@pop3.qualcomm.com” in this field.

Note: Be sure to use your POP account —this may or may not be your e-mail address. If
your e-mail address is different than your pop account, put your e-mail address in the
Return Address field of the Personal Info Options.

In the Real name field, type your real name. It is included in the From field of your outgoing
messages.

Specify a connection method. If you are using Eudora via TCP/IP software (e.g., a direct network
connection, SLIP, or PPP), select Winsock. If you are using Eudora via a Unix shell account, select
Dialup. Most users will select Winsock.
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If your POP and SMTP servers are on the same computer, you do not need to specify an SMTP
server. If they are not on the same computer, click on the Hosts category and enter in the SMTP
field the full name of the computer running the SMTP server.

You are now ready to go. For a quick introduction to Eudora’s basic functions, see the “Tutorial”
chapter; for detailed explanations of all the available functions, see the appropriate chapters.

Quitting Eudora
To quit Eudora, select Exit from the File menu. If you have queued messages, or timed messages
due to be sent in the next 12 hours, you are given the option to send them (see the section “Quitting
with Queued Messages”).

The Trash mailbox is emptied if the Empty Trash when exiting option is on in the Miscellaneous
Options.

Online Help
There are several ways to get online Help with Eudora:

To find out what something in the user interface does, use either Context Sensitive Help from the
Help menu, or the Help button on the toolbar, and click on the item you want to know about. A
brief description of the item is displayed.

The F1 key also displays context-sensitive Help. Select the user interface item you want to know
about, then press F1.

For instructions on how to do certain tasks, select Help Topics from the Help menu. The Help
Contents are displayed, and you can either browse the contents or use the Find and Index options.

Registering Your Copy of Eudora
Use the Register Eudora command (in the Help menu) to register your copy of Eudora and receive
a free electronic newsletter. It covers the latest news and informaton about the Eudora Division of
QUALCOMM Incorporated, our products, e-mail, messaging, and other interesting new applications
and exciting services that can be delivered directly to your electronic mailbox.

If you open the registration screen but don’t want to register at that time, you can choose Not Now to
be prompted 7 days later, or Never Register to never be prompted again. At any time, you can
choose Register Eudora... from the Help menu to display the registration form.

QUALCOMM Incorporated 11



 



Tutorial

Introduction
This tutorial introduces Eudora’s basic functions. There are a host of other operations that are not
described here. For detailed explanations of all available Eudora functions, see the other chapters.

Most Eudora commands can be applied either to an open message window or to highlighted message
summaries in a mailbox window. This lets you apply commands (such as Transfer, Forward, and
Reply) to messages without opening them first. Whenever the term current message is used in this
manual, it refers to a message that is open and is in the topmost window or whose message summary
is highlighted within a mailbox window.

Creating an Outgoing Message
A good way to familiarize yourself with Eudora is to create an outgoing message. An outgoing
message is one that you send to someone else.

From the Message menu, select New Message. A new composition window is displayed. Since it is
easiest to experiment with Eudora by sending a message to yourself, type your own e-mail address in
the To field.

The From field has been automatically filled in and can’t be altered. This is your real name and
return address (as entered in the Real name and Return address fields in the Personal Info
Options).

Press the tab key or point and click the mouse to move the cursor down to the Subject field.
Typically, you would enter some brief text indicating what the message is about. For this message,
type the words Test Message.

Move the cursor past the remaining Cc, Bcc, and Attachments fields down into the large area below
them. This area is reserved for the body of the message. Here you can type whatever text you want.
When you finish your message (referred to in this tutorial as your test message), the composition
window should look something like the following example.

Example test message
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Saving the Message
To save any current outgoing message, such as your test message, select Save from the File menu.
This saves the message in its current state in the Out mailbox, which holds all outgoing mail.

After you save your test message, select Out from the Mailbox menu to view the message summary.
The bullet (•) in the Status column of the message summary indicates that the message has been
saved, and can be sent or queued.

A message saved in the Out mailbox

Sending the Message
Notice the Send button in the upper right hand corner of the composition window. To send the
message, simply click on this button.

The composition window immediately closes, and the progress window is momentarily displayed at
the top of the screen. The progress window shows you the progress of lengthy operations.

Checking for and Receiving the Message
There are two ways to check your POP server to see if you have any new incoming mail. One way is
to set up Eudora to automatically check for mail every so often. The other way is to check for mail
manually whenever you want to by selecting Check Mail from the File menu. Do this manual check
now.

Your password is requested for the first mail check after Eudora is opened, whether it is an automatic
or manual check.

Note: Your POP account password is provided by your e-mail administrator.

The Password dialog

Type in your password and click OK. If you make a mistake before clicking OK, simply backspace
and re-enter the password correctly. If your password is rejected, select Check Mail from the File
menu again and re-enter your password.

Note: Your password is case-sensitive, so the uppercase and lowercase letters must be typed
in exactly. Be sure Caps lock is off.
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After successfully entering your password, a progress window is momentarily displayed at the top of
the screen indicating that an attempt to reach your POP account is being made. If there is a network
problem between you and the POP server, an alert is displayed. Consult with your e-mail
administrator to solve the problem.

If there is no mail waiting at your account on the POP server, the You have no new mail alert is
displayed. This means that the message you sent to yourself in the previous exercise has not been
delivered to your POP account yet. Click OK.

Keep selecting Check Mail from the File menu until your test message arrives. If the message
doesn’t arrive in a minute or two, notify your e-mail administrator.

When mail is found in your POP account, it is transferred to your PC and the progress window lets
you monitor the transfer. This is followed by the You have new mail alert.

Click OK. The In mailbox window is displayed with your test message summary listed inside.

The test message listed in the In mailbox

The mailbox window shows a summary of each message in the mailbox. Incoming messages are
stored indefinitely in the In mailbox until they are deleted or transferred to another mailbox (as
described later in this tutorial).

To select (highlight) the message summary, click anywhere on the summary. To open the message,
double-click on its summary. Do this for your test message to display it on your screen.

The incoming test message
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Replying to the Message
You can easily reply to the sender of an incoming message without having to create a new message
from scratch.

With the test message current, select Reply from the Message menu to initiate a reply to the
message.

A new composition window is displayed, with the sender’s address (in this case, your own)
automatically placed in the To field of the header. The original sender’s text is automatically
included in the body of the message. You can edit this text as needed (or it can be deleted by
pressing the Delete key). You can enter more text in the reply message just as in any outgoing
message. In your test reply, move the insertion point to the area below the original message and type
in some additional text. To send this message, click Send.

A reply to a message

Transferring the Message Between Mailboxes
You can organize your incoming mail by creating new mailboxes and easily transferring messages
among them.

To create a new mailbox and transfer your test message into it, open the In mailbox, select your test
message summary, and select New... from the Transfer menu. The New mailbox dialog is
displayed. Any name can be typed in the new mailbox title field, but for this example, type Testing.

New mailbox dialog

Click OK to create the new mailbox. Because your test message was highlighted when you selected
New... from the Transfer menu, it is automatically transferred into the Testing mailbox. To see this,
select Testing from the Mailbox menu.
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You can also transfer messages among existing mailboxes. To do this, select your original test
message from the Testing mailbox and then select In from the Transfer menu.

Transferring the test message

Deleting the Message
Messages are stored indefinitely in any mailbox until they are deleted or transferred to another
mailbox. Any current message can be deleted.

To delete your test message, open it or select it in the In mailbox. Then, select Delete from the
Message menu. As a safeguard, the Delete command doesn’t actually delete messages, but instead
transfers them to the Trash mailbox. So, if you suddenly realize that you deleted a message you want
to keep, you can transfer it out of the Trash into another mailbox.

All messages stored in the Trash mailbox are automatically deleted when you quit Eudora (although
you can turn this option off). To manually delete messages in the Trash mailbox, select Empty
Trash from the Special menu.
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Creating an Outgoing Message
An outgoing message is a message you send to someone else. The simplest way to create an
outgoing message is to select New Message from the Message menu. A new message window is
displayed, referred to as the Composition Window.

Using the Composition Window
The composition window consists of the title bar, the toolbar, the message header, and the message
body.

The composition window

Title Bar
The Title bar provides information about the message, including the name of the addressee, the time
and date the message was sent, and the message subject.

Toolbar
The toolbar consists of a series of buttons and popups that are displayed just under the title bar. It
allows you to control the priority of your message, override some of your default options for the
current message, and send or queue the message. Each button can be turned on or off for the current
message by clicking on it (a button is on when it is depressed, and off when it is raised). You can set
some of the defaults for the toolbar in the Sending Mail Options.

The popup menus and buttons are described below.

Priority Popup
This lets you indicate that the message is of higher or lower priority than a
normal message. For most messages, this is just an empty box (normal priority).
For details, see the section “Setting the Message Priority.”

Signature Popup
This lets you automatically append one of your signatures to the end of the
message. For details, see the section “Using a Signature in an Outgoing
Message.”
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Attachment Type Popup
This lets you select the encoding format for attachments. For details, see the
section “Attaching a File to a Message.”

Quoted-Printable Encoding
If this is on, quoted-printable encoding is used when sending messages that
contain long lines of text or special characters. It is used for all plain text
attachments. It is recommended that this always be on.

Text As Document
If this is on, plain text files are attached to the message, not incorporated into the
message as part of the message body.

Word Wrap
If this is on, a carriage return is not required at the end of each line. When the
message is sent, the text is automatically “wrapped,” meaning that carriage
returns are inserted at the end of each line of text, with roughly 76 characters per
line.

Tabs in Body
If this is on, pressing the tab key within the message body inserts a tab. If this is
off, pressing the tab key within the message body returns the cursor to the To
field of the message header.

Keep Copy
If this is on, a copy of the message is put into the Out mailbox when the message
is sent. These messages are saved there until they are deleted or transferred.

Send or Queue
These let you send the message immediately or put it in the queue to send later.
If the Immediate Send option in the Sending Mail Options is on, the button is
labeled Send. If the option is off, the button is labeled Queue. For details, see the
section “Sending or Queueing a Message.”

Message Header
Outgoing mail headers consist of the following fields: To, From, Subject, Cc, Bcc, and
Attachments. Each field is described below. The To, Subject, Cc, and Bcc fields can be directly
edited. To move the cursor from field to field, press the tab key or click in the desired field with the
mouse.

To resize the Header region of the outgoing message window, drag the separator up or down.

To
The intended recipients’ e-mail addresses, or nicknames you have defined (see the section “Using
the Address Book and Quick Recipient List”). Multiple addresses and nicknames must be separated
by commas.

From
The sender’s e-mail address. This is usually your POP account plus your real name. You can use a
return address other than your POP account by entering the address in the Return address field of
the Personal Info Options.

Subject
Some brief text indicating the contents of the message. This field can be left blank (though it is a
breach of e-mail etiquette to do so).
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Cc
The e-mail addresses or nicknames of people to whom a copy of the message is to be sent. These
recipients are displayed in the message header for all recipients to see. Multiple addresses must be
separated by commas. This field can be left blank.

Bcc
The e-mail addresses or nicknames of people to whom a copy of the message is to be sent. These
recipients are not displayed in the message header, and the recipients in the To or Cc fields will not
know that a copy went to these addresses. Multiple addresses must be separated by commas. This
field can be left blank.

Attachments
A list of documents being attached to and sent along with the message. You must use one of the
attachment options to add attachments (see the section “Attaching a File to a Message”). To delete
an attachment from an outgoing message, select it and press the delete key. This field can be left
blank.

Message Body
After filling in the header fields, move the insertion point to the space below the message header.
Type the body of the message here.

Word Wrap
If you turn on the Word Wrap button in the message toolbar, when the message is sent carriage
returns are automatically inserted at the end of each line of text, with roughly 76 characters per line.
This makes the message legible on the recipient’s computer.

It is a good idea not to include your own carriage returns within paragraphs if you have this option
on. Only use carriage returns to create new paragraphs.

To manually wrap text, select the text you want, then select Wrap Selection from the Edit menu. To
unwrap text, select the text you want, then hold down the Shift key and select Wrap Selection from
the Edit menu.

To copy wrapped text without taking the carriage returns, hold down the Shift key and select Copy
from the Edit menu.

Using a Signature
A signature is a few lines of text that are automatically added to the end of an outgoing message
when it is sent. A signature can be whatever you want, but it is mostly used to give contact
information (telephone, address, etc.).

Note: Your signature is not displayed in the Eudora message window, but is added to the
end of the message when it is sent.

To create or modify the Standard or Alternate signature, select it from the Signatures submenu on
the Tools menu. The Signature window is displayed. Enter your signature text, and select Save from
the File menu to save your changes.

Creating the signature
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To include the Standard or Alternate signature in an outgoing message, select it from the Signature
popup in the message window.  To set the Signature popup to Standard for all new messages, turn
on Use signature in the Sending Mail Options.

Setting the signature for a particular message

Setting the Message Priority
You can assign a priority to incoming and outgoing messages. The priority is only for you and your
recipients—it does not affect the way mail transport systems handle the messages.

There are five priority levels available, 1 being the highest, 5 being the lowest. Each is represented
by a small symbol in the Toolbar of a message window and the Priority column of a message
summary. Priority 3 is used for messages that have no assigned priorities, and it is not displayed. The
high and highest priority symbols are red.

New messages are created with a Normal priority. To change the priority of the current message, use
the Priority popup.

Changing the priority of a message using the priority popup

Note: To set up Eudora to always use the sender’s priority on your replies, turn on the Copy
original’s priority to reply option in the Replying Options. You can always change
the priority in the message window.

Attaching a File to a Message
Any file can be attached to and sent with a Eudora message. Most of the time, an attached document
functions like a “rider” to the e-mail message, and does not appear within the message text. Instead,
the name of the document is displayed automatically in the Attachments field of the message
header.

To attach a file to an outgoing message, select Attach File [to New Message] from the Message
menu. The Attach File dialog is displayed. Locate the file you want, select it, and click on the Open
button to attach the document to the current message, or open a new message with the file attached.
You can add as many attachments as you want to a message.

You can also drag one or more files from the Desktop onto the message window to attach them.
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To detach a document before the message is sent, select the document in the Attachments field, then
press the delete key or select Clear from the Edit menu.

When the message is sent it is encoded in the selected attachment type. This allows you to send any
kind of document through the mail, even applications.

If the document is an ASCII file, you can put it in the body of the message by turning off the Text as
Attachment button in the message toolbar, or by turning on the Put text attachments in body of
message option in the Attachments Option.

The attachment types include the following:

MIME
This is best for recipients with MIME-compliant e-mail readers, regardless of what operating system
they are using. For more information on MIME, see Appendix D.

BinHex
This is best for recipients on a Macintosh with an e-mail reader that is not MIME-compliant.

Manually Decoding Attachments
If you send an attachment and your recipient’s e-mail program does not automatically decode it, it
will probably be included in the body of the message in the chosen attachment format (MIME,
BinHex, or Uuencode).

If you recieve a large message consisting largely of indecipherable text, it is probably an attachment
that was not automatically decoded. Usually this is because the attachment headers are formatted
incorrectly.

To decode an attachment that was not automatically decoded, open the message and select Save As
from the File menu to save the message as a text file. Then run the decoding utility appropriate for
the encoding method that the sender used. Decoding utilities can be found at various shareware sites
on the Internet.

Including a URL in a Message
To include a URL (Uniform Resource Locator) in a message, enclose it with less than and greater
than signs to ensure that your recipient’s application can identify it as a URL. For example,
<http://www.eudora.com/>.

A URL in an outgoing message
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Saving a Message for Later Changes
Sometimes it is convenient to save an outgoing message either as a safeguard when typing long
messages, or so you can return to it later to make changes.

To save the current message, select Save from the File menu. Saved messages are put in the Out
mailbox with a bullet (•) in the Status column. This indicates that the message has been saved and
can be sent or queued.

A message saved in the Out mailbox

You can continue making changes or close the message. If you try to close an outgoing message
window without saving that version of the message, an alert is displayed asking if the message
should be saved or the changes discarded. If you select Discard and the message has never been
saved, the message is deleted.
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Sending or Queueing a Message
After you compose a message, you can send it immediately or put it in a queue to be sent later.

Note: Most SMTP servers do not  require a password to send mail. For information about
setting up a password check for sending mail, see the section “Troubleshooting.”

Sending a Message Immediately
If you want to send your messages immediately instead of putting them in a queue to send later, then
be sure the Immediate send option is on in the Sending Mail Options.

To send the current message, click on the Send button or select Send Immediately from the
Message menu. A progress window is displayed to show the progress of the transmission.

If you have the Immediate send option on, but want to put the current message in the queue, hold
down the Shift key and click on the Send button. The Change Queueing dialog is displayed and you
can set detailed instructions. For more details, see the section “Queueing a Message to Send at a
Certain Time.”

Queueing a Message to Send Later
If you want to put your messages in a queue (in the Out mailbox) to send all together at a later time,
be sure the Immediate send option is off in the Sending Mail Options.

You can set up Eudora to warn you if you try to delete a queued message, or try to quit Eudora with
queued messages. To do this, turn those options on in the Extra Warnings Options.

To put the current message in the queue, click on the Queue button or select Queue For Delivery
from the Message menu. The message window is closed (if it was open), the message is saved in the
Out mailbox marked Q (meaning it’s ready to be delivered),  and the date and time are placed in the
Date column.

To send all of your queued messages, select Send Queued Messages from the File menu. A
progress window is displayed momentarily at the top of the screen indicating the progress of the
transmission.

If you have the Immediate send option off, but want to send a message immediately, hold down the
Shift key and click on the Queue button. The Change Queueing dialog is displayed and you can
select the Send message Right Now option.
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Queueing a Message to Send at a Certain Time
You can specify that a message be sent at a certain time in the future. To do this for the current
outgoing message, select Queueing... from the Change submenu off of the Message menu. The
Change Queueing dialog is displayed.

The Change Queueing dialog

If you choose Right Now, the message is sent immediately when you click OK. If you choose Next
time queued messages are sent, the message is sent the next time queued messages are sent.

If you choose On or After, you can use the Time and Date fields to fill in the time and date when
the message should be sent. The message is saved in the Out mailbox with a T in the status column,
and the specified date and time in the Date column. The message is sent when the specified time
arrives.

Important:  For the message to be sent at the correct time, Eudora must be running at that
time. If Eudora is not running, the message is sent the first time Eudora is run after
the specified time has passed.

If you choose Don’t Send for a message that has never been queued, nothing happens. The message
is held in the Out mailbox until it is either deleted or re-queued and sent.

Editing a Queued Message
To edit a queued message, open the Out mailbox and double-click on the message summary. Make
the necessary edits and save them. The message is kept in the Out mailbox. If you close the changed
message without saving it, an alert is displayed asking you to verify the changes.

Taking a Message Out of the Queue
A message that is queued but is not yet sent can be unqueued using the Change Queueing
command. Open the Out mailbox and select the desired message summary. Then, select Change
Queueing... from the Message menu and click on Don’t Send. This changes the message status
from queued (Q) to saved (•). The message is held in the Out mailbox until it is either deleted, re-
queued, or sent.

Sending Queued Messages When Checking Mail
If the Send on check option in the Sending Mail Options is on, every time Eudora checks for mail
(automatically or manually), all queued messages are automatically sent.
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Keeping Copies of Outgoing Messages
There are two ways to keep copies of your outgoing messages: To put a copy of every outgoing
message in the Out mailbox, turn on the Keep copies option in the Sending Mail Options; To put a
copy of the current outgoing message in the Out mailbox, turn on the Keep Copy button in the
message toolbar.

In both of these cases, when the messages are sent they are put in the Out mailbox with an S in the
Status column, indicating that the message has been sent.

If neither of these options are used, outgoing messages are put into the Trash mailbox.

Note: You can also set up a filter to save outgoing messages in particular mailboxes based
on information contained in the message. See the section “Filtering Messages” for
more information.
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Checking For Incoming Mail
The POP server is where your mail is received and stored until it is transferred by Eudora to your
PC. The information for your POP account is specified in the Getting Started Options.

Note: To best understand the functioning of the POP server with respect to Eudora, see
Appendix C.

There are two ways to check your POP server and transfer mail to your PC: automatically or
manually. These are described in the sections below.

Checking for Mail Automatically
To set up Eudora to automatically check your POP account and transfer new mail, open the
Checking Mail Options and in the Check for mail every ? minutes field, enter the number of
minutes that you want between mail checks. As long as Eudora is running, your POP account is
checked for new mail at the specified interval.

Note: 15 minutes is a good minimum interval, because checking mail more frequently puts
an unnecessary load on your POP server.  If the field is empty, or is set to 0, mail is
not automatically checked.

If automatic checking is set, the Check Mail command under the File menu displays
the next time that an automatic check is scheduled to occur.

Checking for Mail Manually
You can manually check for new mail at any time by selecting Check Mail from the File menu.

Note: If automatic checking is on and you manually check for new mail, the next automatic
mail check will happen at the specified number of minutes after the manual check.

Stopping a Mail Check
If you want to stop a mail check in the middle, click on the Stop button in the progress window.

Using Your Password
Each time you open Eudora and check mail for the first time, you need to enter a password for your
POP account. This password is required by the POP server before it will transfer your mail, so that
no one else can get your mail from the server.

Note: This does not protect your mail once it is on your PC. Unless a message has been sent
with some type of security, it is just plain text, which many applications can read. If
you are interested in securing the messages on your PC, you may want to consider a
disk driver that can encrypt hard disk data.

If you need to enter a password, the Eudora Password dialog is displayed. Enter your password and
click OK. If you make a mistake before clicking OK, simply backspace and re-enter the password
correctly.
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The Password dialog

 Note: Your POP account password is case-sensitive, so the uppercase and lowercase
characters must be typed in exactly. Be sure that Caps Lock is off.

If your password is rejected, an error message is displayed indicating that you have entered the
wrong password. Select Check Mail from the File menu to redisplay the password dialog.

As long as Eudora is running, it remembers your password. If you don’t want it to remember (if, for
example, you are away from your PC), select Forget Password from the Special menu. The next
time you check mail, you are prompted for your password again.

You can also make Eudora remember your password from one session to the next, which means you
never have to enter your password again, even if you quit and restart Eudora. You only want to do
this if your PC is in a secure location, where there is no possible chance of someone else having
access to it. To use this option, turn on Save password in the Checking Mail Options.

Changing Your Password
To change your password,  select Change Password from the Special menu. You are prompted to
enter your old password once, and your new password twice. Depending on the server you are using,
the password can be up to 30 characters, but normally it is only 7 or 8.

Note: This only works if the POP server is running a compatible password-change server.
For information about these servers, see Appendix A.)

When you choose a new password, try not to use real words, names, dates, familiar acronyms, etc.
Some systems require at least one number or symbol in your password, and you may want to do that
even if it is not required.

Receiving New Mail
When Eudora does a mail check, you can be notified of new mail in one or all of the following ways:
an alert dialog, the opening of the mailboxes to which new mail is delivered, and a special “New
Mail” sound. These options are turned on or off in the Getting Attention Options.

Note: For the sound alert to work, you may need a sound driver for the PC speaker (see
“Appendix A” for a source for this driver).

Mail usually arrives in the In mailbox (unless you are using filters to transfer messages). If the In
mailbox is not already open, select In from the Mailbox menu. The messages are listed in the order
they are received, with the most recent message listed last. Unread messages are designated by a
bullet (•) in the Status column of the message summary.

Double-click anywhere on a message summary to open the message. Incoming messages are saved
indefinitely in the In mailbox (or the mailbox they are filtered into) until they are deleted or
transferred to another mailbox.
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The Incoming Message Window
To open an incoming message, double-click on its message summary in a mailbox window, or, if the
message summary is current (highlighted), press the space, enter, or return key.

An incoming message window

The incoming message window consists of the title bar, the toolbar, and the message body.

Title Bar
The Title bar provides information about the message, including the name of the sender, the time and
date the message was delivered, and the message subject.

Toolbar
The Toolbar consists of buttons and popups displayed just under the title bar.

Tow Truck
This can be used to drag any current message into a different mailbox. Just hold
the mouse button down on the icon and drag it to an open mailbox or a mailbox
in the Mailboxes window.

BLAH,BLAH,BLAH
If this is on, all the message headers (and any formatting codes) are displayed.

Pencil
If this is on, you can edit the message.

Fetch
If this is on, the message is transferred in full the next time you check mail. This
button is only displayed if the message was originally transferred in part. For
details, see the section “Managing Your Mail on the POP Server.”

Priority Popup
This lets you indicate that the message is of higher or lower priority than a
normal message. For most messages, this is just an empty box (normal priority).
For details, see the section “Setting the Message Priority.”

Subject
This is the subject that was assigned by the sender, and is shown in the message
summary. For instructions on changing this subject, see the section “Editing
Incoming Messages.”

Message Body
The message body contains the message header and text information, as well as the name of each
attachment. Attachments can be opened from within the message window by double-clicking on the
attachment.
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Receiving Attachments
Unless you have specified a particular directory for your incoming attachments (see the section
“Specifying an Attachment Directory”), they are automatically decoded and saved in the Attach
Directory in your Eudora Directory. If you receive multiple attachments with the same name, a
number is added to the end of each duplicate name, in the order they are received.

Attachment names are displayed at the bottom of incoming messages. To open an attachment from
the message window, double-click on the attachment name. If you have the application that the
attachment was created in, that application launches and the attachment opens.

If you recieve a large message consisting largely of indecipherable text, it is probably an attachment
that was not automatically decoded. Usually this is because the attachment headers are formatted
incorrectly. To decode an attachment that was not automatically decoded, open the message and
select Save As from the File menu to save the message as a text file. Then run the decoding utility
appropriate for the encoding method that the sender used. Decoding utilities can be found at various
shareware sites on the Internet.

Specifying an Attachment Directory
If you do not want to use the default Attach Directory to receive your attachments, select Options...
from the Tools menu and select the Attachments Options. Then click on the large button beneath the
Attachment Folder prompt. A standard file dialog is displayed.

Double-click on the name of the directory you want to use (its name should be displayed in the menu
above the list), then click the Use Directory button. The dialog closes, leaving the Options dialog
displayed. The name of the folder you just selected is now displayed in the Attachment Directory
button.

Note: If at any time Eudora cannot find your selected directory, Eudora will use the Attach
Directory in the Eudora directory for attachments until you designate a new
directory.

Editing Incoming Message Subjects
To edit the subject of an incoming message, open it and edit the subject in the toolbar (not the
subject in the message body). When you are done, click somewhere else in the message, or close it.
The new subject is displayed in the message summary. The contents of the Subject field of the
message header remain unchanged.

Note: If you reply to the message, the original subject is used for the reply, not your
changed subject. This gives you the freedom to put information useful to you into the
summary, without fear of your private notes being revealed to your correspondents.

Editing Incoming Messages
You can edit the message body in an incoming message if you turn on the Pencil button in the
Toolbar. You can also edit the Subject in the Toolbar (this is the subject shown in the message
summary). To edit an incoming message, click on the Pencil button to turn it on, then edit the
message body. When you are done, save your changes and close the message.

To edit the subject of an incoming message, open it and edit the subject in the Toolbar (not the
subject in the message body). When you are done, click somewhere else in the message, or close it.
The new subject is displayed in the message summary. The contents of the Subject field of the
message header remain unchanged.

Note: If you reply to the message, the original subject is used for the reply, not your
changed subject. This gives you the freedom to put information useful to you into the
summary, without fear of your private notes being revealed to your correspondents.
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Using Active URLs
Any string of text that Eudora recognizes as a URL (Uniform Resource Locator: http, ftp, gopher,
ph, finger, etc.) is active. Double-click on a URL to open a World Wide Web location, transfer a file,
do a gopher search, use the finger tool, etc. URLs are highlighted and underlined to show that they
are active (32-bit Eudora only).

To setup Eudora to automatically open a new message when you use a mailto link within a Netscape
Web browser, turn on the Intercept Netscape mailto URLs option in the Miscellaneous Options.
(Be sure you are not running the Mailto Watcher application at the same time.)

Managing Your Mail on the POP Server
During a mail check, your incoming messages are normally transferred from your account on the
POP server to your PC, and then deleted from the POP server. But this can be awkward if you want
to read mail from two or more computers, and keep your mail organized at the same time. To help
you with this, there are several options that you can use to control your mail transfers and the storage
on the server.

Skipping Messages Over a Certain Size
To stop Eudora from transferring incoming messages that are too large, turn on the Skip messages
over ? K in size option in the Checking Mail Options, and specify a size. Only the first few lines of
the messages that exceed that size are transferred, with a note at the bottom stating that the whole
message has not been transferred.

Leaving Mail on the Server
To transfer all of your new messages from the POP server to the PC you are on, and also leave
copies of those messages on the server, turn on the Leave mail on server option in the Checking
Mail Options. You can use the Delete from server after ? days option to set the maximum number
of days the copies should be kept.

At the next mail check from that PC, Eudora ignores the copies of those previously read messages
and looks for new ones. However, if you check mail from another computer, those messages are
treated as new and are transferred to that computer.

Note: The Leave mail on server option should be used with care, since it can result in a
buildup of messages on the POP server.

Fetching a Message from the Server
If a message was too big for your Skip messages over ? K in size option, but you see the first few
lines and decide you do want to transfer the whole message, just click on the Fetch button in the
incoming message window and check mail again.
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Replying to a Message
To reply to the current message, select Reply from the Message menu. A new message window is
displayed, with the original sender’s address automatically placed in the To field of the header. All
of the sender’s original text is quoted in the message body. This text can be edited as needed.
Additional text can be added to the reply just as to any outgoing message, and the reply can then be
sent or saved for further changes.

If the sender’s text did not include style information, each line is prefixed by a greater-than symbol
(>).

Quoted text that does not include style information

If the sender’s text did include style information (e.g., bold text), it is quoted with greater-than and
less-than symbols above it and below it, and a left sidebar.

Quoted text that includes style information

Messages that have been replied to are identified with an “R” in the Status column of their message
summary.

Using the Reply Options
There are several options that you can use when replying to messages.

To include everyone who received the original message, select Reply to All from the Message
menu.

To include yourself as a recipient, turn on the Include yourself option in the Replying Options. This
only works if you are using Reply to All.

Note: To determine who you are, Eudora uses the “me” nickname. If there is no “me,”
Eudora uses the contents of the POP account and Return address fields from the
Personal Info Options. The “me” nickname is particularly useful if you have multiple
addresses and don’t want replies to go to any of those addresses.

To put the addresses of the other recipients of the original message in the Cc field (instead of the To
field), turn on the Put original To recipients in Cc field, not To field option in the Replying
Options. Only the original sender’s address is put in the To field. This only works if you are using
Reply to All.

To copy the original message’s priority to your replies, turn on the Copy original’s priority to
reply option in the Replying Options.

To map Ctrl-R to Reply to All instead of Reply, turn on this option in the Replying Options.
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Forwarding a Message
Any message can be forwarded to someone else. To forward the current message, select Forward
from the Message menu. A new message window is displayed with your address in the From field,
and the original sender’s text quoted in the message body. For details on how text is quoted, see the
section “Replying to a Message.” Make any changes you want, and enter the recipients’ address in
the To field. The message can then be sent or saved for further changes.

Messages that have been forwarded are identified with an “F” in the Status column of their message
summary.

Redirecting a Message
Incoming messages can be sent to a new recipient “by way of” you, maintaining the original sender’s
address in the From field. This is called redirecting.

To redirect the current message, select Redirect from the Message menu. A new message window is
displayed with the original sender’s address in the From field with the statement “by way of your
address”, the original sender’s text in the message body, and the original attachments in the
Attachments field. Make any changes you want, and enter the recipient’s address in the To field.
The message can then be sent or saved for further changes.

Note: You may want to enclose any changes in brackets ([]) so that you don’t confuse the
recipient about who wrote what.

A Redirected message

Messages that have been redirected are identified with an “D” in the Status column of their message
summary.

Turbo Redirecting
You can redirect a message to someone on your recipient list, queue the new message (without
displaying it), and delete the original message, all with one command. To do this, turn on the Turbo
redirect by default option in the Miscellaneous Options.

When you use Redirect, your signature is not added to the message when it is sent, unless you
originally created the message.
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Sending Rejected Messages Again
If for some reason an e-mail message can’t be delivered to a recipient, mail transport agents return
the message to the original sender (you). A message is typically rejected because of an error in the
recipient’s address, although many other reasons are possible.

The return message usually includes cryptic information that may let you determine the reason the
message was rejected. It also includes the text of the original message.

You can easily recover the original message, make any corrections, and resend it. To do this for the
current message, select Send Again from the Message menu. This eliminates the inserted extra text
and reformats the message as it originally appeared. You can then make changes or additions and
send the message again.
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Working with Mailboxes

Opening a Mailbox
To open a mailbox, select it from the Mailbox menu, or double-click on it in the Mailboxes window.

Note: The unread message icon is displayed in the Mailbox menu whenever a mailbox or
folder contains unread messages that are less than five days old, and any mailboxes
or folders in the Mailboxes window that conatin unread messages are displayed as
bold.

The Anatomy of a Mailbox
Mailbox windows contain all of your incoming and outgoing message summaries. To open a
mailbox, select it from the Mailbox menu, or double-click on it in the Mailboxes window.

A mailbox window

Message Summaries
Each line in a mailbox window represents a message and is called a message summary. Outgoing
messages that are in any mailbox other than Out are shown with italicized message summaries. To
select one or more message summaries, use one of the following options:

• To select one summary, click on it.

• To select two summaries and all the summaries between them, select a summary, hold down the
Shift key, and select another summary.

• To select all of the summaries that have the same information in a particular column, hold down
the Alt key and click on a column in the summary. For example, if you click on the Status column
for one summary, all of the summaries with that status are selected.

• To make “disjointed” selections, hold down the Ctrl key and select summaries.

• To select summaries by dragging the mouse over them, first turn off the Allow drag and drop
transfers option in the Miscellaneous Options.
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Each message summary is divided into columns: Status, Priority, Attachments, Sender/Recipient,
Date, Size, and Subject. You can show or hide these columns using the Mailbox Columns Options.

A message’s Status and Priority can be changed directly in the mailbox window. To do this, select
the messages you want to change and click the right mouse button. Select an option from the popup
menu to make your change.

The Status Column
This column displays the message status, which is one of the following:

• The message has not been read (all mailboxes except Out), or is queueable but has not
been queued (Out mailbox only).

<blank> The message has been read (all mailboxes except Out), or is not yet able to be queued
because it has no recipients (Out mailbox only).

R Reply has been chosen for the message.
F Forward has been chosen for the message.
D Redirect has been chosen for the message.
S The message has been sent (outgoing messages only).
Q The message is queued to be sent (outgoing messages only).
T The message is queued to be sent at a specified time (outgoing messages only).
- The message was transferred from the Out mailbox before being sent.

The Priority Column
This column displays the message priority. You can use the popup to set a particular priority, or to
raise or lower the priority.

Highest priority.

High priority.

<blank> Normal priority.

Low priority.

Lowest priority.

For more information on message priorities, see the section “Setting the Message Priority.”

The Attachments Column
This column displays the attachment icon ( ) if a message has attached documents.

The Sender/Recipient Column
This column shows the sender of the message (for incoming messages) or the intended recipients
(for outgoing messages).

Note: Bugs in some POP servers/mail transport systems cause Eudora to display the sender
of incoming messages as ???@???. This is because the required From: header is
missing.

The Date Column
This column displays the date and time the message was composed, or, for timed messages, the date
and time the message is scheduled to be sent.

The Size Column
This column displays the size of the message in K (K = 1024 bytes).

The Subject Column
This column displays the subject of the message. The sender originally typed this information into
the message header, but you can modify it (see the section “Editing Message Subjects”).
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Displaying and Resizing Columns
To specify which columns you want to be displayed in your mailboxes, select Options... from the
Tools menu, click on Mailbox Columns and be sure the columns you want to see are on.

To resize a column in a mailbox window, move the mouse pointer until it is over the column heading
divider to the right of the column you want to resize, drag the divider to the position you want. The
column divider moves to the new location, and the mailbox is redrawn. You can only shrink a
column as far as its left divider. If you do that, a double divider line is displayed in place of the
column, and its contents are hidden. To redisplay the column, drag the right divider line to the right.

Using the Mailbox Size Display
In the lower left corner of each mailbox window, three numbers show the size information for that
mailbox. The first is the number of messages in the mailbox; the second is the total amount of space
those messages require; the third is the amount of disk space that is wasted with the mailbox.

Wasted space is created when messages are deleted from a mailbox. This wasted space is
automatically removed when the amount of wasted space in the mailbox is greater than the amount
of space the messages in the mailbox use, or if the amount of space wasted in the mailbox is greater
than 5% of the free space on the disk drive that contains it.

To manually clean up the wasted space in a mailbox, click on the mailbox’s size display. Or, to clean
up all your mailboxes, select Compact Mailboxes from the Special menu.

Creating Mailboxes and Folders
Eudora lets you create mailboxes to put messages in, and folders to put mailboxes (or folders) in.

There are three ways to create mailboxes and folders:

• Using the New option from the Mailbox menu and folder submenus.

• Using the Mailboxes window (see the section “Using the Mailboxes Window”).

• Using the New option from the Transfer menu (see the section “Transferring Messages”).

Creating a Mailbox or Folder Using the Mailbox Menu
To create a new mailbox or mail folder, select New... from the Mailbox menu, or from a mail folder
submenu (to put the mailbox in that folder). The New mailbox dialog is displayed.

New mailbox dialog

To create a mailbox, type in the new mailbox name and click OK. The mailbox is created and added
to the Mailbox and Transfer menus.

To create a mail folder, type the name of the new mail folder and check the Make it a Folder option.
Click OK to create the folder. The new mailbox dialog is displayed again. Type the name of a
mailbox to create within the new folder, then click OK. The new folder and its mailbox are
displayed in the Mailbox and Transfer menus.
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Using the 16-bit Mailboxes Window
The 16-bit  Mailboxes window lets you create new mailboxes and folders, remove and rename them,
and move mailboxes among folders. To accomplish any of these tasks, select Mailboxes from the
Tools menu. The Mailboxes window is displayed.

The 16-bit Mailboxes window

The Mailboxes window has two identical lists of mailboxes and folders, each called Top Level.
These list the names of the mailboxes and folders you have created (folders are identified by an
arrow to the right of the name). Each list is similar to that displayed under the Mailbox and Transfer
menus, except that the In, Out, and Trash mailboxes aren’t included.

If the Mailbox window isn’t big enough to display all of your created mailboxes and folders, use the
scroll bar on the right side of either list to view the rest of the mailboxes and folders.

Note: Double-clicking on any of the mailboxes in a list opens that mailbox. Messages can
be selected, opened, and otherwise manipulated from there.

To open a folder and display its contents in the list, double-click the folder. To change the folder
being displayed in the list, select another folder from the title popup.

Creating a New Mailbox or Folder
To create a new mailbox or folder in the Mailbox window, be sure one of the lists is displaying the
folder you want to put the new item in. Then click on the New button below that list. A dialog is
displayed requesting the name of the new mailbox or folder.

Type in the new name, check the Make it a Folder option if you want to, and click OK. The new
mailbox or folder is displayed in the lists, and added to the Mailbox and Transfer menus.

Renaming a Mailbox or Folder
To rename a mailbox or folder, select the one you want to rename (from either list) then click on the
Rename button under that list. A dialog is displayed requesting the new name. Type in the new
name and click Rename to rename the mailbox or folder.
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Moving a Mailbox from one Folder to Another
To move a mailbox from one folder to another, select the one you want to move (from either list). In
the other list, open the destination folder so that its name is displayed above the list. Click on the
appropriate Move button to move your selection to the other folder.

Removing a Mailbox or Folder
To remove a mailbox or folder, select the ones you want to remove (from either list) then click on
the Remove button under that list. A dialog is displayed asking you to confirm the removal. Click on
the Remove It button to remove the mailbox. If you selected more than one mailbox or folder, you
are prompted for each one of them. Click on the Remove All button to remove all of them without
further prompts.

If you choose to remove a mailbox in which messages are still stored, or a folder in which other
mailboxes or folders are stored, all the messages, mailboxes, and folders contained within the
selected mailbox are also removed.

Using the 32-bit Mailboxes Window
The 32-bit Mailboxes window lets you create new mailboxes and folders, remove and rename them,
and move mailboxes among folders. Mailboxes or folders that are bolded have unread messages.

The Mailboxes window is  automatically docked to the left side of the Eudora application window,
and can also be docked to the right side of the Eudora window, or placed anywhere on your desktop.
You can right-click the mouse button to toggle Docking view (floating vs. attached to the
application window) or Hide on and off.

To open the Mailboxes window if you’ve hidden it, select View Mailboxes from the Tools menu.

The 32-bit Mailboxes window

To move the Mailboxes window, hold down the left mouse button on the gray rim of the window
and drag it where you want it. If you drag it to the left or right edge of the Eudora window, it will
dock in a vertical position in the Eudora window.

To open a mailbox or folder, double-click on it. You can move among the folders and mailboxes
using the up and down arrow keys, or close or open folders using the left and right arrow keys. You
can also start typing the name of the mailbox or folder you want, and it is highlighted when you have
typed enough unique characters to identify it (the item must be displayed, so a mailbox that is in a
closed folder cannot be selected).

Creating a New Mailbox or Folder
To create a new mailbox or folder in the Mailbox window, right click on a folder and click New. A
dialog is displayed requesting the name of the new mailbox or folder.

Type in the new name, check the Make it a Folder option if you want to, and click OK. The new
mailbox or folder is displayed in the lists, and added to the Mailbox and Transfer menus.

Renaming a Mailbox or Folder
To rename a mailbox or folder, click on it once, then click again to highlight just the name (or right
click on it and select Rename). Type in the new name.
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Moving a Mailbox from one Folder to Another
To move a mailbox from one folder to another, select the one you want to move and drag it to where
you want it.

Removing a Mailbox or Folder
To remove a mailbox or folder, select the one you want to remove then select Delete from the right
mouse button or use the Delete key.

If you choose to remove a mailbox in which messages are still stored, or a folder in which other
mailboxes or folders are stored, all the messages, mailboxes, and folders contained within the
selected mailbox are also removed.
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Deleting a Message
As a safeguard against inadvertent deletions, two steps are used to delete a message from your PC:
first you put the message in the Trash, then you empty the Trash.

To put a message in the Trash, select the message then select Delete from the Message menu, or
select Trash from the Transfer menu, or press the delete key. The message is transferred to the
Trash mailbox.

To delete the messages in the Trash mailbox (removing them permanently from your PC), select
Empty Trash from the Special menu.

You can set up Eudora to warn you if you try to delete unread, queued, or unsent messages. To do
this, use the Extra Warnings Options to turn on those options.

Quitting Eudora empties the contents of the Trash mailbox when the Empty Trash when exiting
option in the Miscellaneous Options is turned on. Finally, if you want to delete just a few messages
from the Trash mailbox, select them, then select Delete from the Message menu or press the delete
key. Deleting a message from the Trash removes it completely.

Automatically Deleting Attachments
When you delete messages, you can have their attachments automatically deleted. To do this, turn on
the Delete attachments when emptying Trash option in the Attachments Options, and be sure the
attachments are still in the Attach Directory (or the directory you have specified for attachments). If
you have this option on, and want to delete a message but save its attachment, move the attachment
into another directory before deleting the message.

Transferring Messages
You can transfer messages to any of your mailboxes. There are several ways to do this:

• Select the message(s) you want to transfer, then select a mailbox from the Transfer menu.

• Select the message(s) you want to transfer, then right-click on it and select a mailbox from the
transfer submenu.

• Drag a message summary to an open mailbox or a mailbox in the 32-bit Mailboxes window (this
does not work with the 16-bit Mailboxes window).

To put a copy of a message in another mailbox (instead of transferring the message), hold down the
Shift key and use one of the transfer options above. This is useful if you want to file a message in
more than one mailbox.

To put a copy of a message in another mailbox (instead of transferring the message), hold down the
Shift key and use one of the transfer options above. This is useful if you want to file a message in
more than one mailbox.

If you try to transfer a message to the Out mailbox, an alert is displayed informing you that some
header information may be removed from the message during transfer. Click Yes to transfer the
message.

Note: You can undo mailbox transfers using the Undo command under the Edit menu.
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Using the Transfer menu
The Transfer menu is one way to transfer messages among your mailboxes. With a current message
open, or message summaries selected, select a mailbox from the Transfer menu. The messages are
transferred from their previous mailbox to the mailbox you selected.

Dragging Messages
You can drag messages from one mailbox to another using the message summaries or the Tow Truck
icon in an open window.

To drag a message summary to another mailbox, select the message summary (or summaries) and
drag the summary into any open or minimized mailbox window, or (if you are using the 32-bit
version) any mailbox in the Mailboxes window. When you release the mouse button, the message is
transferred.

To drag an open message to another mailbox, hold down the mouse over the Tow Truck icon and
drag the message into any open mailbox or  (if you are using the 32-bit version) any mailbox in the
Mailboxes window. When you release the mouse button, the message is transferred.

Note: You can only drag messages around if the Allow drag and drop transfers option is on
in the Miscellaneous Options.

Creating a Mailbox or Folder During Transfer
To create a mailbox and transfer the current message into it at the same time, select New... from the
Transfer menu instead of the name of a mailbox. The New Mailbox dialog is displayed.

You can create a new mailbox or mail folder (for details, see the section “Creating Mailboxes and
Folders”). When you are done, the current message is transferred into the new mailbox.

To create the new mailbox without transferring the message into it, check the Don’t transfer, just
create mailbox option.

46 QUALCOMM Incorporated



Eudora User Manual Organizing Your Messages

Filtering Messages
Some of the e-mail management functions in Eudora can be done automatically using filters. To
open the Filters window, select Filters from the Tools menu. The Filters window is displayed, and
any filters you have created are listed on the left.

The Filters window with an example filter

To create or modify a filter, first click on the New button or select an existing filter.

Second, select the options for how you want the filter to be used: as an automatic filter to be invoked
on any Incoming and/or Outgoing mail, and as a Manual filter that can be invoked when you select
Filter Messages from the Special menu. Any combination of these options works.

Third, define the criteria for the filter: use the header item popups and the text fields to specify which
header items should include a particular string of text. You can define two related terms for the
criteria so that your filter is as specific as possible (see the section “Filter Criteria”).

Fourth, Define the action to be taken on messages that fit the criteria (see the section “Filter
Actions”) and save the filters.

Note: Filters are automatically named based on the criteria for the filter. You can re-order
them using the Up and Down buttons above the list.

When the filters are invoked (automatically or manually), each message is matched against each
filter in order from top to bottom. If the message meets a filter’s criteria, the actions are done as
specified until there are no more actions, then the message is matched against the next filter. If at any
point a Skip rest action is done, nothing else is done with that message, and the next message is
filtered.

You can change the width of the filters list to create more or less space for your list. To do this, put
the arrow over the bar to the right of the list and drag the line to the left or right.
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Filter Criteria (the Match Area)
Each filter can use one or two “terms” as its criteria, connecting them as appropriate with the
conjunction popup.

Use the Header field to specify which message header items you want the filter to search. You can
select an option from the popup menu or enter one yourself. This is helpful if you want to use a
header item that does not appear on the menu. The selections are as follows:

• To
• Cc
• From
• Subject
• Reply-To
• «Any Recipient»
• «Any Header»
• «Body»

The «Any Recipient» option searches all possible recipient items (To, Cc, Bcc), the
«Any Header» option searches all message headers (including hidden headers that are shown
with the Blah Blah Blah option), and the «Body» option searches the message body.

Use the Match Type popup to control how the header item is matched with the text string in the text
field. The match options are:

contains or doesn’t contain
If the specified header item contains or does not contain the text string, filter the message.

is or is not
If the specified header item is or is not a complete match of the text string, filter the message.

starts with or ends with
If the specified header item starts with or ends with the text string, filter the message. The starts
with item refers to the first non-whitespace character after the colon, so any spaces after the
colon are ignored.

appears or doesn’t appear
If the header item appears or does not appear in the message, filter the message (the text field is
ignored). This is useful for filtering messages based only on the types of fields they contain.

intersects nickname
If the text string is included in a nickname (whether it is a full address or a nickname within the
nickname), filter the message.

Use the Text fields to specify the text strings that the filter is searching for. Keep the contents of this
field as specific and brief as possible

Use the Conjunction popup to link the two terms. The conjunction options are:

ignore
Ignore the second term; if the message matches the first term, filter the message.

and
If the message matches both the first and second terms, filter it.

or
If the message matches either term, filter it.

unless
If the message matches both the first and second terms, do not filter it. (This lets you exclude
certain variations of the first term.)
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Filter Actions
All messages that match the filter criteria are acted on as specified with the Actions popups. Each
filter can do up to five things to a message that matches the criteria. You can use the same action
twice if it does not directly affect the original message (for example, Copy To can be used twice, but
not Transfer To).

The Action options are as follows:

None
No action.

Make Priority
Assigns the selected priority level to messages. If you select a set level, messages are set to that
priority. If you select Raise or Lower, messages are raised or lowered one priority level based on
their pre-filter level.

Make Subject
Assigns the new subject to message summaries (does not affect the suject in the message itself). If
you choose this option, the entire subject of the message is replaced with the new subject. Use the
“&” symbol if you want to add the new subject to the old subject. For example, entering New
Subject:& results in New Subject:Old Subject.

Copy To
Copies messages to the selected mailbox.

Transfer To
Transfers messages to the selected mailbox.

Skip Rest
Stops filtering for the message (the message is not matched to the rest of the filters in the list).

Sorting Messages Within Mailboxes
The message summaries in mailboxes are automatically sorted by date, in ascending order (the
newest messages at the bottom of the mailbox). To change this, select the appropriate command
from the Sort submenu from the Edit menu. To sort in descending order, hold down the Shift key
and select a sort option.

The Sort submenu

Mailboxes are sorted based on the previous state of the mailbox. For example, if a mailbox is sorted
by date, and then you sort by sender, the messages are grouped by sender and each group is in order
by date.

Note: Sometimes sorting by Date can be incorrect. This usually happens if the messages
have incorrectly formatted date fields, or unknown or incorrect time zones.
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Finding Text Within Messages
Eudora incorporates a Find function that searches for specific text within a single message, multiple
messages, or even multiple mailboxes.  To display the Find submenu of commands, select Find from
the Edit menu.

The Find submenu

Finding Text Within One Message
To search for text within a single message, open the message and make sure it is current.  Then,
select Find from the Edit menu and select the Find command from the submenu.  The Find dialog is
displayed, with the blinking insertion point located in the text field.

Type the text you want to find in the text field.  When finished entering the desired text, click the
Find button.

Finding text

Starting at where the cursor is in the message, Eudora searches the current message for the specified
text.  If no match is found, the not found alert is displayed.

If the search is successful, the message is scrolled to the first point where the match is found and the
matching text is highlighted.

To continue searching in the same message for the next occurrence of the text, click the Find button
in the Find dialog, or select the Find Again command from the Find submenu.  These commands
are equivalent and limit the search to the same message.  Repeating these commands cycles through
the matches in the open message only.

Finding Text Among Multiple Messages and Mailboxes
The Next, Next Message, and Next Mailbox commands are located in the Find submenu (under the
Edit menu) or as buttons in the Find dialog.

Next
The Next button (or Next command) allows you to search for the next match of the specified text
until it is found either in the same message or in one of the following messages in the current
mailbox.

Next Message
The Next Message button (or Next Message command) begins the search at the message after the
current message.  Eudora continues to search until it finds a matching character string, even if it has
to open more than one message or a new mailbox.
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Next Mailbox
The Next Mailbox button (or Next Mailbox command) begins the search for the specified text in the
mailbox following the current mailbox.  The search is conducted among all messages in that mailbox
and any subsequent mailboxes, including the In, Out, and Trash mailboxes.

Note: Mailboxes are searched in the order they are listed under the Mailbox menu until the
current mailbox is reached.

When the character string is found in a message, the message is displayed.  Ctrl+
double-click on the message title bar to open the mailbox that contains the message.

Match Case
Normally, Eudora ignores capitalization when searching.  If you want Eudora to consider
capitalization when searching, check the Match Case option in the Find dialog.  When this option is
checked, Eudora searches for exact matches of character strings, including any capitalization.

Summaries Only
If you know the text you are searching for is included in a message summary, check the Summaries
Only option in the Find dialog.  When you click the Find button, Eudora searches for the text only in
the Sender and Subject fields of message summaries as they appear in mailbox windows.  Eudora
searches much faster when this option is checked.

Enter Selection Command
If you don’t want to actually type the text in the Find dialog (for example, the text is very long or
complex), highlight it in an existing message, and then select Enter Selection from the Find
submenu.  This automatically inserts the selected text at the insertion point in the Find dialog.  Then,
select the Find command from the Find submenu to start the search.

Stopping a Find
If you want to stop Eudora from continuing a search, click the Stop button on the progress window
or press the Esc key.

Saving a Message to a File
You can save a message to a separate text file on your PC. To do this, open or select the messages
you want to save. Then, select Save As... from the File menu. The Save As dialog is displayed.

The Save As dialog

Enter the name you want to give the text file, and select the appropriate options.

Important:  Be sure to change the Save as type: option to Text Files.
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Guess Paragraphs removes extraneous carriage returns from the message leaving returns only at the
ends of paragraphs.

Include Headers retains the first message’s header information in the saved document. If this is not
checked, only the body of the messages is saved.

Once you’ve made all of your choices, click on the Save button in the dialog.

Note: If an unread (•) message is saved to a file, its status changes to read, regardless of
whether the message was opened.

If you select multiple messages from a mailbox window and select Save As..., all of the messages
are saved to a single file.

52 QUALCOMM Incorporated



Using the Address Book and
Quick Recipient List

Using the Address Book
The Address Book is where you keep information about individuals or groups that you correspond
with. Each entry in the Address Book includes a nickname for a person or group, their full e-mail
addresses(es), and any notes. Nicknames can be used in place of proper e-mail addresses in the To,
Cc, and Bcc fields of outgoing messages. You can also use the Address Book to put nicknames on
the Quick Recipient List, and to address a new message.

To open your Address Book, select Address Book from the Tools menu.

The 32-bit Address Book with example entries

Use the View By option to display the entries by nickname or address(es). If you view by a field that
doesn’t contain any data, the entry is displayed with «». You can also start typing in the list of
entries, and the appropriate entry will be selected when you enter enough unique characters to
identify it.

To page up and down in the list of entries, use the arrow keys. To resize the list, drag the divider.

To close and open the right-hand side of the Address Book, use the « and » buttons.

Creating New Entries
To create a new entry, click on New in the Address Book. A dialog is displayed. Enter a Nickname
for the entry. A Nickname (sometimes called an alias) is an easily remembered, shorter substitute for
the e-mail addresses in the entry.
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Creating a new entry

Select the Put it on the recipient list option if you want the nickname on your list, and click OK to
create the entry. Then you can enter the information for that entry.

In the Address(es) tab, enter the complete e-mail addresses of the people (or person) to be included
in the nickname, separating the addresses with commas or returns (this is the only place you can use
a return to separate addresses). You can also use nicknames in this field, but be sure that any
nicknames you use are defined in their own entry. You can use a mix of nicknames and complete
e-mail addresses.

Note: Be sure there is no other information in this field except addresses or nicknames, or
your messages will be addressed incorrectly.

In the Notes tab,  you can enter contact information for the person or group, and any notes to
yourself. This information is not included in outgoing messages.

It is recommended that you have at most 2,500 entries per file. If you have a large number of entries,
you may want to consider using a Ph server (for information, see Appendix A).

To save your changes to the Address Book, select Save from the File menu.

Changing and Removing Entries
To make changes to an Address Book entry (including changing the name of the entry, the nickname
for it, and any information in the Notes tab), select the entry from the list and edit the fields as
appropriate.

Important:  If you change a nickname, but sure to correct any entries that reference that
nickname.

To delete an entry, select it from the list and click on the Del button or press the Delete key. You
cannot delete the Eudora Nicknames file.

To save your changes, select Save from the File menu.

Including Nicknames on the Quick Recipient List
To include a nickname in the Quick Recipient List, select the appropriate Address Book entry from
the list and click on the Recipient List option (next to the Nickname field). The nickname for the
selected entry is included on the Quick Recipient List.

The Recipient List option
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If you change a nickname or remove an entry, the Quick Recipient List is updated as appropriate.
For details about using the Quick Recipient List, see the section “Using the Quick Recipient List.”

Note: You can add or remove multiple nicknames to or from the Quick Recipient List by
selecting multiple entries. Hold down the Shift key to select multiple entries in
sequence, or the Ctrl key to make disjoint selections.

Addressing a Message from the Address Book
You can open and address a new message from the Address Book using the To, Cc, and Bcc buttons.

To create a new message from the Address Book, select the entry to which you want to address the
mail (hold down the Shift key to select multiple entries in sequence, or the Ctrl key to make disjoint
selections). Then click on To, Cc, or Bcc. A new composition window is displayed with the selected
nickname(s) inserted in the appropriate field.

Note: You can also double-click on an entry to enter that nickname in the To field.

Once the composition window is displayed, you can use the To, Cc, and Bcc buttons to insert
additional nicknames into the corresponding fields.

The “Make Address Book Entry” Command
The Make Address Book entry command is used to create entries in your Address Book, and is
especially helpful for making group entries.

In the Address Book, highlight several different entries (hold down the Shift key to select multiple
entries in sequence, or the Ctrl key to make disjoint selections), then select Make Address Book
Entry... from the Special menu. The New Nickname dialog is displayed prompting you for the
nickname of the new entry. The Address(es) field of the new entry will include the nicknames for
the entries you selected, not the real addresses.

In a mailbox, highlight the message summaries you want and select Make Address Book Entry...
from the Special menu. The New Nickname dialog is displayed prompting you for the nickname of
the new entry. Follow the instructions for creating a new entry. If the current message is an outgoing
message, the new entry will include all of the addresses in the To, Cc, and Bcc fields. If the current
message is an incoming message, the new entry will include the address in the From field. If
multiple messages are current (i.e., you have several message summaries selected in a mailbox
window), addresses are taken from each message and are all put in the new entry.

Note: The Make Address Book Entry command uses the Reply Options. If the Include
yourself option is on, your address is included in the new entry.

In the Directory Services window, finish a Ph query, select the items that you want to include in the
entry (or do not select anything to use all of the items), and select Make Address Book Entry...
from the Special menu. The New Nickname dialog is displayed so that you can name the nickname.
The real name and e-mail address are included in the new entry.

The “Finish Address Book Entry” Command
With the Finish Address Book Entry command, you can enter a unique portion of a nickname in
the To, Cc, or Bcc fields of a message, then select Finish Address Book Entry from the Edit menu,
and the nickname will be completed for you. You must enter the characters in the nickname that
make it unique, or Eudora will not know which nickname to use. For example, if you have two
nicknames, jon and john, you would have to enter “jon” or “joh” for Eudora to complete them.
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Using the Quick Recipient List
The Quick Recipient List is your list of recipients to whom you often send mail.

To add a nickname to the Quick Recipient List, check the Recipient List option in its Address Book
entry.

To add a full e-mail address to the Quick Recipient list, select the text that makes up the full address.
Then, select Add As Recipient from the Special menu.

To remove an entry from the list, uncheck the Recipient List option in the Address Book entry, or
select the nickname from the Remove Recipient submenu from the Special menu.

To open a new message addressed to someone on your Quick Recipient List, select New Message
To, Forward To, or Redirect To from the Message menu, and select the nickname from the
displayed list.

To insert a nickname into a message that you have already opened, put the cursor where you want
the nickname and select Insert Recipient from the Edit menu.

More than one recipient from the Quick Recipient List can be added to the To, Cc, and Bcc fields of
any message. If you use the Insert Recipient command, commas are added where necessary.
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Opening Directory Services
Eudora can access two different directory services, Ph and Finger. To use these services, you must
put the name of the host machines for the Ph and finger servers in the Hosts Options. The active Ph
or finger server (defined in your Host Options) is displayed in the Server field, which includes a
popup list of the last 10 servers you have accessed.

To use the directory services, select Directory Services from the Tools menu.

Using Ph
To look someone up using Ph, enter the information (usually someone’s name) into the command
field and click on Ph. The command is sent to your Ph server, and the response is displayed in the
lower section of the window.

If there is more than one match, you can use the Tab key to move down to the next one, or hold
down the Shift key and press Tab to move up to the previous one.

A Ph command and its response

Note: You can type any Ph command in the command field, except login commands or
commands requiring login. For information about the Ph server source code, see
Appendix A.

Finding Ph Servers
Some Ph servers keep a list of other Ph servers that are available on the Internet. This is not always a
comprehensive list of every Ph server out there, but it can be helpful.

To get the list of servers that the active server knows about, click on the Server button in the
Directory Services window. A list of servers is displayed in the results area. To go to one of those
servers and do a query, double-click on the server’s URL.

Using Finger
To use the Finger protocol, enter the command and click Finger. The command should be in the
form “name@domain.” If you omit the “@domain” segment, the host name displayed in the Server
field is used. The finger command is sent to the finger server, and the response is displayed in the
lower section of the window.
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The Main Toolbar
The Main Toolbar is a group of buttons that gives you easy access to your frequently used Eudora
commands.

The Main Toolbar

The 32-bit toolbar can be moved to wherever you want it on the screen. Just hold down the left
mouse button on the bar itself (not on a button) and drag it around until you find a place you like.
You can dock it to the top or bottom of the Eudora window or put it anywhere on your desktop. The
16-bit toolbar cannot be moved.

The Main Window Icon
The main window icon displays when Eudora’s main window is minimized.  It provides a unique
indication of when new mail has been delivered, when outgoing messages are queued, or both.

Normal
This is the normal state of the icon.  There is no new mail and no messages are
queued and waiting to be sent.

New Mail
The mailbox is open and has a letter in it, indicating that new mail has been
delivered.

Queued Messages
The flag on the side of the mailbox is in the up position, indicating that you have
outgoing messages queued for delivery.

New Mail/Queued Messages
The mailbox is open and has a letter in it and the flag on the side of the mailbox
is in the up position, indicating that new mail has been delivered and outgoing
messages are queued for delivery.

If you are using the 32-bit version of Eudora under Windows 95 or Windows NT 4.0, a New Mail
notification icon in the Task Bar Tray also tells you when new mail has arrived. You can hold the
mouse over the icon and a tool tip tells you how many messages you have, and if you double-click
on the icon Eudora is brought to the foreground. The icon goes away when you click the mouse
button or press a key inside the Eudora window.
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The Right Mouse Button
The commands that are available from the right mouse button are generally the same as those on the
main menu and toolbar, it is simply another access method.

To use the right mouse button commands, place the arrow over a Eudora window and click on the
right mouse button, then select a command from the list that is displayed. The list varies depending
on which window you are in and what tasks you might need to perform while in that window.

If you have Eudora minimized, you can check for new mail without maximizing the icon. To do so,
place the arrow over the Eudora icon, click on the right mouse button, and select Check Mail.

Printing
To print the current message or item, select Print... from the File menu. Eudora automatically prints
headers and footers on each page, giving the window title, page number, and your return address.

Plugins (Extended Messaging Services)
Plugins are special add-ons that can be installed to add features to Eudora. For example, you could
use a language conversion plugin to translate a message to another language, a security plugin to
automatically secure a message, or a text manipulation plugin to change lowercase to uppercase.
Plugins interface to Eudora using the Extended Messaging Services Application Programming
Interface (EMSAPI).

To make plugins available to Eudora, put them in the Plugins directory in your Eudora directory,
then restart Eudora. Depending on the plugin type, it will be available in Eudora through the
following methods:

• The Message Plugins submenu (in the Edit menu) typically includes plugins that are used to
modify the text of a message. These are referred to as on-request plugins. Some samples of these
types of plugins are available with Eudora: Sort, UpperLower, and Unwrap.

• Icons in the message window are typically for plugins that are used to manipulate messages as
they are sent or when they are received. These are referred to as on-transmission and on-display
plugins .

• The Tools menu typically includes plugins that are used to do tasks that are not directly related to
Eudora functions. These are referred to as tools plugins.

• The Attach submenu (in the Message menu) typically includes plugins that are used to create and
attach particular files to a message. These are referred to as attachment plugins.

• Plugins that are automatically used when a message is received are not available through the user
interface.

To see all of your currently installed plugins, select Message Plugins Settings from the Special
menu. If a plugin has any settings options, you can use the Settings button to change them.

For information about available plugins, send e-mail to <eudora-rep@eudora.com> or visit the
World Wide Web site <http://www.eudora.com/>.
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The Messaging Application Program Interface (MAPI)
MAPI is an interface that lets you send e-mail messages from any MAPI-compatible application,
such as your word processor, spreadsheet, graphics application, etc. See Appendix F for technical
details on the Eudora MAPI server.

MAPI-compatible applications have a Send or Send Mail option in the File menu. When you select
the option, the Eudora MAPI server displays a new outgoing message with your current document
attached. All you need to do is address the message, type any details you want to include in the body
of the message, and click Send or Queue.

To run the Eudora MAPI server, use the MAPI Options dialog. To display the MAPI Options dialog,
select Options... from the Tools menu and click on the MAPI category (see the “Options Dialog”
section).

You have several options in the MAPI Options dialog for loading the Eudora MAPI server. You can
set it to always run or to run only when Eudora is running, or you can specify that it never run. These
three options open or exit the server as soon as you select them.

Note: When you are running the Eudora MAPI server, Microsoft Exchange will not work. If
you need to use Exchange, turn off the Eudora server.

You also have several options for saving or deleting MAPI attachments. When you use MAPI to
attach a file and send a message, that file is immediately copied into the Attach directory (or a
directory you have specified). You can use the MAPI options to save those copies, delete them after
sending their corresponding messages, or delete them after their messages are emptied from the
trash.

Putting Multiple Users on One PC
You can set up Eudora so that more than one user can be on a single PC.  You will need to Exit and
reopen Eudora to switch users.

Multiple users with Windows 3.x or Windows NT 3.51
To have multiple users on one PC, make a separate directory for each user and copy the original
eudora.ini file into each one (the directories can be put anywhere you like, including on floppies or
network drives). Then create a separate program item for each user and point the command line to
the new eudora.ini file, as shown in the example below:

Correcting the properties for each user’s program item

Note: Be sure to change the account information in the Getting Started Options.

If you don’t already have a program item set up for your original Eudora directory, you should
probably do that. Be sure that the command line gives the path to the original eudora.ini file.
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 Multiple users with Windows 95 or Windows NT 4.0
To have multiple users on one PC, make a separate mail directory for each user (the directories can
be put anywhere you like, including on floppies or network drives), and put a copy of the eudora.ini
file into each user’s directory. Then, for each user, create a shortcut to the Eudora executable
(eudora.exe). Right-click on the new shortcut and select Properties, then click on the Shortcut tab.
In the Target field, add the path to the user’s eudora.ini file, as shown in the example below.

Specifying a mail directory

Note: Be sure to change the account information in the Getting Started Options.

62 QUALCOMM Incorporated



Eudora User Manual Reference

Troubleshooting
Occasionally, you may encounter a problem or bug when using Eudora; this section includes
information to help you solve those problems. You can also check the Eudora Technical Support
Web Pages at <http://www.eudora.com/techsupport>.

If you are having problems, try the following:

Be sure that you have the current release of Eudora.

Be sure that your POP account is set correctly. This is probably different than your e-mail address,
so double-check that you have the right information.

Be sure your SMTP server is set correctly. This may or may not be the same machine as your POP
server.

Be sure you are entering your password correctly, paying attention to upper and lower case letters
(make sure the Caps Lock key is off).

Be sure the date is correct on your computer, especially the year.

Be sure the Winsock option is on (in the Getting Started Options) unless you are using a shell
account. (If you can use a browser, use Winsock.)

 Be sure Eudora can find your winsock.dll. If Eudora cannot find it, be sure the Path line in your
AUTOEXEC.BAT file includes the directory that contains the winsock.dll. Or, if you do not want
to edit your AUTOEXEC.BAT file, try copying your winsock.dll into the Eudora directory.

Toggle both of the Use asynchronous Winsock calls options (turn them on if they’re off, or vice
versa) in the Advanced Networking Options.

Run ScanDisk to check for problems on the hard drive.

If you’re having trouble with your mailboxes (especially with repeated requests to rebuild a
mailbox’s table of contents), quit Eudora and find the mailbox’s .toc file in the Eudora directory.
Change the .toc extension to .000, then open Eudora and see if the problem persists.

Windows 95 users: If you’re having other problems, especially crashes, remove all of the items in
your Startup directory (C:\Windows\Start Menu\Programs\StartUp), then restart Windows while
holding down the F8 key. In the Startup menu, select Safe Mode. Then open Eudora and see if the
problem persists.

Errors
The following are possible errors and alerts you could recieve from Eudora, and suggestions for
fixing them.

“-ERR Maildrop lock busy”

This usually happens after your PC has “hung” during a mail check and you are now
attempting to re-connect to the mail server.  The best thing to do is to contact your e-mail
administrator and tell them that you have a POP3 server process that needs to be disconnected.

“503 Need RCPT (Recipient)”

You must include at least one recipient in the To field for your message to be delivered. If you
have a nickname in the To field, be sure that in the Address Book at least one e-mail address or
valid nickname is included in the Address(es) tab. If the Address(es) tab is blank, there are no
recipients and this causes the error.
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“Error getting a network socket. Cause: no buffer space available (10055)”

The buffers the error message is referring to are TCP buffers.  TCP/IP stacks need buffers
where they can store data that goes to/from the network. Since at a low level the data has to be
sent to a hardware device, the buffers generally have to be in low memory (i.e., < 1MB).  This
is valuable space for most users, so most TCP/IP stacks have a way of controlling how many of
these buffers the user wants allocated.  If you’re using a lot of other network applications at the
same time (especially X Windows, which uses a buffer for each window), then you might get
this error.  The other case that this error might occur is the TCP/IP stack not correctly marking
buffers as being unused, so you have a buffer not being used that the stack thinks is being used.

“Could not rename lmos.tmp to lmos.dat”

Quit Eudora, and go to your Eudora directory.  Find the files called lmos.tmp and lmos.dat and
delete them both (lmos.tmp may not be there, that’s not a problem).  On your next mail check
you may get some mail that you have already received, but that should only happen once.

Formatting and Printing
The following are possible formatting and printing problems, and suggestions for fixing them.

You received a message containing columns and the columns are not lining up correctly.

Your screen font is probably a proportional font. Change your display font to a non-
proportional font (such as Courier) in the Fonts & Display Options.

You have a message that is printing with strange line breaks.

When most e-mail programs send out messages, they insert hard returns at around 75-80
characters. (If they didn’t, some e-mail applications would only be able to display the first 80
characters or so of a very long line of text.) What's happening with your message is that the
width of the line that fits on the printed page is shorter than 75-80, so the hard returns end up in
the wrong place.

The solution is to make the print font smaller, or choose a font that is closer together (like
Helvetica instead of Courier, for example).  These settings are in the Fonts and Display
Options.

Miscellaneous
You want to set up a password check for sending mail, not just checking mail.

SMTP servers, which are used to send mail for most e-mail accounts, do not require a
password for access like a POP server does. However, if the POP daemon your server is using
is descended from the UC Berkeley POPper, you can use the POPSend protocol, which routes
SMTP calls through the POP server, so the POP server requires the password.

If you turn this feature on in your POP server, add this line to the Settings section of the
eudora.ini file:

UsePOPSend=1

This means you will have to enter your password to send as well as check mail.  However, it's
not terribly secure since users who know what they’re doing can simply remove that .ini file
line or uncheck the Use XTND XMIT option and disable the feature.  But it will protect you
against inexperienced but unscrupulous users.
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The Options Dialog
The Options dialog lets you specify how you want to use Eudora. To display the Options dialog,
select Options... from the Tools menu.

The Options dialog contains many categories, which are described below. The default setting for
each option is listed in brackets after the name of the option.

Note: For your convenience, some options appear in more than one category. For example,
your real name appears in both the Getting Started and Personal Info Options.
Changing a setting in one group changes the setting in all groups.
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Getting Started
The Getting Started Options determine the minimum information necessary to send and receive mail.

The Getting Started Options

POP account [none]
This is the address for your account on the POP server. Enter your POP account name, an “@” sign,
and the full domain name of the computer. For example, if your assigned POP account name is
“justine,” and the name of the computer where you receive e-mail is “pop3.qualcomm.com” type
“justine@pop3.qualcomm.com” in this field.

Note: Be sure to use your POP account —this may or may not be your e-mail address. If
your e-mail address is different than your pop account, put your e-mail address in the
Return Address field of the Personal Info Options.

Real name [none]
This is your real name. It is included in the From field of outgoing mail.

Connection method [Winsock]
This specifies how you are connecting to the network. If you are using Eudora via TCP/IP software
(e.g., a direct network connection, SLIP, or PPP), select Winsock. If you are using Eudora without
TCP/IP software, select Dialup. If you don’t want Eudora to attempt to make any connections, select
Offline.
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Personal Info
The Personal Info Options determine your personal information.

The Personal Info Options

POP account [none]
This is the address for your account on the POP server.

Real name [none]
This is your real name. It is included in the From field of outgoing mail.

Return address [none]
This is your e-mail address. It is included in the From field of outgoing messages, and when a
recipient replies, this address is used. Your POP account is used if you do not enter an address here.

Note: If you do enter an address in this field, first test the address to be sure that mail sent
to it is indeed delivered to you. If you use an invalid return address, no one will be
able reply to your mail.

Dialup username [none]
This is your dialup username. If you use Eudora with the Communications Toolbox, and you have a
secondary user name for use during the dialup process, enter it here (e.g., your login name on a
terminal server). See Appendix E for details regarding how this field can be used.
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Hosts
The Hosts Options determine what servers to use.

The Hosts Options

POP account [none]
This is the address for your account on the POP server.

SMTP [none]
This is the name of your SMTP server. If the computer that your POP account is on also runs an
SMTP server, you can leave this field blank.

Ph [none]
This is the name of your Ph server. It is necessary for doing Ph queries in the Directory Services
window.

Finger [none]
This is the name of your finger server. If you leave this blank, Eudora uses your SMTP server as
your finger server.

68 QUALCOMM Incorporated



Eudora User Manual Reference

Checking Mail
The Checking Mail Options determine how Eudora checks for and receives your incoming mail
messages.

The Checking Mail Options

POP account [none]
This is the address for your account on the POP server.

Check for mail every ? minutes [none]
If this is on and you enter a number, Eudora automatically checks your POP server for new mail at
regular intervals and transfers any mail addressed to you to your PC. The number you enter specifies
the number of minutes between checks. It’s a good idea to set this at no less than 15 minutes.
Checking mail more frequently puts an unnecessary drain on your POP server. This option only
works when Eudora is running. Leaving this field empty disables automatic checking (even if the
box is checked).

Skip messages over ? K [off, 40]
If this is on, messages over the specified size are downloaded only in part. These messages include
the first few lines, and a statement that says the message is not complete. This can be useful on slow
connections. For details, see the section “Managing Your Mail on the POP Server.”

Send on check [on]
If this is on, any messages that are queued in the Out mailbox are sent when mail is checked
(automatically or manually).

Save password [off]
If this is on, your password is remembered even if you quit and restart Eudora, so you’ll never be
prompted to enter it. Only use this option if your PC is in a secure place.

Leave mail on server [off]
If this is on, Eudora copies incoming messages to your PC and leaves the message on the POP
server. For details, see the section “Managing Your Mail on the POP Server.”

Delete from server after ? days [off, 0]
This option has a check box for turning it on and off and an edit box for specifying the number of
days mail that was left on the server should be saved before being deleted.  It is a good idea not to
leave copies of your messages on the server indefinitely, as this will create mail storage problems on
the server.
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Determine first unread message by [First message not read by this machine]
Eudora has the capability to track unread messages on your desktop, instead of relying solely on the
POP server to mark the messages as unread.  This option allows you to select what constitutes an
unread message.

The choices are as follows:

First message not read by this machine - any message not previously read by this machine is
considered unread.

Status: headers - any message not identified as read in the message Status: header is considered
unread.  Old versions of Eudora used this method exclusively.

POP3 LAST command - any message after the LAST downloaded message is considered unread.
This method is more efficient than the Status: headers method when connecting to a POP server that
supports the LAST command.

If you want to get all your messages on multiple PCs, on each PC select First message not read by
this machine, and set the Delete from server after ? days to a number of days that will allow you
to check for mail on each PC.

If you want to get all your messages on one PC but also want to be able to read new messages from
other machines, on each PC select First message not read by this machine.  On the PC that you use
for all your messages, turn off Leave mail on server. On the PCs that you use to read new mail, turn
on Leave mail on server.

Delete from server when emptied from trash [off]
If this is on, any messages that are deleted from your Trash mailbox are also deleted from the POP
server. For details, see the section “Managing Your Mail on the POP Server.”

Authentication [Passwords]
This specifies which authentication technology to use: Passwords, Kerberos, or APOP. Ask your e-
mail administrator which one to use.
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Sending Mail
The Sending Mail Options determine how Eudora sends your outgoing messages.

The Sending Mail Options

Return address [none]
This is your e-mail address.

Domain to add to unqualified names [none]
This is the domain name that Eudora automatically adds to an unqualified name. An unqualified
name is a name that doesn’t have an “@” sign followed by a domain name. This can be used to save
time when addressing large numbers of messages to users in the same domain.

SMTP server [none]
This is the name of your SMTP server. If the computer that your POP account is on also runs an
SMTP server, you can leave this field blank.

Immediate send [on]
If this is on, the rightmost button in the Toolbar of the message composition window is labeled Send.
Clicking on this button immediately sends the message to the SMTP server. If this option is off, the
button is labeled Queue and clicking on it places the message in the Out mailbox marked ready for
delivery (Q).

Send on check [on]
If this is on, any messages that are queued in the Out mailbox are sent when mail is checked
(automatically or manually).

Word wrap [on]
If this is on, the Word wrap option is on in the message toolbar. This means that carriage returns are
automatically inserted in long lines when the message is sent, creating roughly 76 characters per line.
This makes the message legible on the recipient’s computer. It is a good idea not to include your
own carriage returns within paragraphs if you have this option on—only use carriage returns to
create new paragraphs. It is strongly recommended that you leave this option on.

May use Quoted-Printable [on]
If this is on, the QP option is on in the message toolbar. This means that Eudora uses quoted-
printable encoding when necessary, such as when messages that contain long lines of text or special
characters are sent. If this option is off, quoted-printable encoding is never used. It is recommended
that you leave this option on.
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Keep copies  [off]
If this is on, the Keep copy option is on in the message toolbar. This means that a copy of the
message will be put in the Out mailbox when the message is sent. If this option is off, outgoing
messages are put in the Trash mailbox after they are sent.

Tabs in body of message [on]
If this is on, the Tabls in body option is on in the message toolbar. This means that when you press
the tab key within the message body a tab is inserted. If this option is off, pressing the tab key within
the message body moves the cursor to the To field.

Use signature [off]
If this is on, the Signature popup in message toolbars is set to Standard. You can always change the
setting for a particular message.
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Replying
The Replying Options determine how replies are created.

The Replying Options

Map Ctrl+R to “Reply to All”[off]
If this is on, when you hold down the Ctrl key and press R, a new message is created addressed to all
of the recipients of the original message.

Copy original’s priority to reply [off]
If this is on, your replies use the same priority as the original message.

When replying to all [off]
This specifies how to address a reply. If Include yourself is on, when you Reply to all (as described
above) your address is left in the address list of the new message and you receive a copy of your own
reply. If this option is off, your address is removed from the reply message and you do not receive a
copy of the reply. If Put original To: recipients in Cc: field, not To: field is on, the addresses of
the original message recipients are moved from the To field to the Cc field of the reply to all
message. Only the address of the original sender is placed in the To field.
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Attachments
The Attachments Options determine how Eudora sends and receives attachments.

The Attachments Options

Encoding Method [MIME]
This specifies what Encoding Method to use for attached documents. To change the method for just
the current message, use the Attachment Type popup in the outgoing message window. For details,
see the section “Attaching a File to a Message”).

Put text attachments in body of message [off]
If this is on, Eudora puts any plain text attachment you send directly in the message body, as if it
were typed in manually.

Attachment Directory [none]
This specifies what directory to put incoming attachments into. To specify a folder, single-click on
the folder name button. A dialog is displayed prompting you to select a folder.

Delete attachments when emptying Trash [off]
If this is on, Eudora automatically deletes an attachment received with a message when that message
is deleted. The attachment must still be in the folder defined as the Attachments Folder. If you want
to save an attachment but delete the message, move the attachment to another folder or turn this
option off.

Delete Automatic attachments: [When message emptied from Trash]
This specifies how to handle attachments to automatically generated messages, such as is created
with the Insert System Configuration command.

Never
If this is on, automatic attachments are never deleted from the attachment directory.

After sending message
If this is on, automatic attachments are deleted from the attachment directory when their
corresponding messages are sent.

When message emptied from Trash
If this is on, automatic attachments are deleted from the attachment directory when their
corresponding messages are emptied from the trash.
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Fonts & Display
The Fonts & Display Options determine how Eudora displays windows and text.

The Fonts & Display Options

Screen Font: [Courier New,9]
This field lists the font to be used for displaying the text of your Eudora messages and mailbox
windows.  It also lists the point size of the font.  To change the selection, click on this field.  The
Font dialog is then displayed, allowing you to select a new font and size.

Print Font: [Courier New,12]
This field lists the font to be used when printing messages using the Print... command.  It also lists
the point size of the font.  To change the selection, click on this field.  The Font dialog is then
displayed, allowing you to select a new font and size.

Message Window Width: [80]
This field specifies the width of new and received message windows (in characters).  If you leave
this field blank, the default value is 80.  This setting has no effect on what your mail looks like when
it is sent.  When mail is sent, Eudora wraps at or before 76 columns.

Note: If you use a proportional font, Eudora sets the window width based on the average
width of the characters in the font.

Message Window Height: [20]
This field specifies the height of new and received message windows (in lines).  If you leave this
field blank, the default value is 20.

Note: If the Zoom windows when opening option is turned on, received message window
heights are automatically adjusted to the height of the message text.

Zoom windows when opening [on]
If this option is on, new message windows automatically open to their “zoomed” size.  The zoomed
size is computed on a window-by-window basis.  For message windows, zoomed size is just long
enough to display all of the message (but no longer than the main window), and as wide as the
Message Window Width setting.  Composition windows zoom to the height specified by the
Message Window Height setting.

Show toolbar [on]
If this option is on, the main window toolbar is displayed (see the “Main Window Toolbar” section).
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Show toolbar tips [on]
If this option is on, holding the mouse pointer over a button in the main window toolbar displays a
very brief description of that button’s function.

Show status bar [on]
If this option is on, Eudora displays a status bar at the bottom of the main window.  The status bar
provides a brief description of menu items and toolbar buttons.

Show category icons [on]
This option allows you to turn the Category icons in the Options dialog on and off.
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Styled Text
The Styled Text Options determine how styled text is received.

The Styled Text Options

When receiving styles pay attention to
If any of these are on, they can be displayed in incoming messages (if the message includes the
style).
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Mailbox Columns
The Mailbox Columns Options determine which columns are displayed in mailbox windows.

The Mailbox Columns Options

Show columns [Status, Priority, Attachments, Sender, Date, Size, Subject]
If any of these options are on, that column is displayed in mailbox windows.
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Getting Attention
The Getting Attention Options determine what Eudora does when it is running in the background
and wants your attention, or when new mail arrives.

The Getting Attention Options

Use an alert [on]
If this is on, an alert dialog notifies you when new mail is received.

Open mailbox (new mail only) [on]
If this is on, mailboxes are automatically opened when new mail arrives in them, and the first unread
message of the last unread batch of messages is selected.

Play a sound [on]
If this is on, a sound is played when Eudora needs attention. To select a sound (.wav) file, click on
the button below the Play a sound option.  The Select sound file dialog is then displayed, allowing
you to select a sound.

Generate Filter Report [on]
If this is on, a filter report is generated when filters are used.
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Extra Warnings
The Extra Warnings Options determine whether you are warned before making a possible mistake.
Most of the warnings are displayed with an option to stop that warning from being displayed again.
If you chose that option, you can turn the warning back on using the Extra Warnings Options.

The Extra Warnings Options

Delete unread mail [on]
If this is on, you are warned if you try to delete unread mail.

Delete queued mail [on]
If this is on, you are warned if you try to delete queued mail.

Delete unsent mail [on]
If this is on, you are warned if you try to delete unsent messages.

Queue a message with no subject [on]
If this is on, you are warned if you try to queue a message with no subject.

Quit with messages queued to be sent [on]
If this is on, you are warned if you try to quit Eudora and you have queued messages.

Queue a message bigger than ? k [on, 500]
If this is on, you are warned if you try to send a message whose size is more than the specified
number. This number must be between 0 and 1000000.

Set a changed message back to read-only [on]
If this is on, you are warned if you try to make an edited incoming message uneditable.

Empty the Trash mailbox [on]
If this is on, you are warned if you try to empty the Trash mailbox. Once messages are deleted from
the Trash, they are completely gone.

Start Eudora and it’s not the default mailer [on]
If this is on, you are warned if you try to start Eudora when it’s not the default mailer. When Eudora
is the default mailer, “mailto” commands open a Eudora message, regardless of what application the
command is in.
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Dialup
These options set the dialup configuration.

Important:  Do not use the Dialup connection option unless you have a Unix shell account.
Most users have a SLIP, PPP, or direct network account and can use the Winsock
connection method.

The Dialup options

Dialup username: [none]
Type your dialup user name in this field. Leave this field blank if your dialup username is the same
as your POP account username.

Phone number: [none]
Type the dialin phone number for your terminal server here. When using Eudora from a location that
requires a prefix (such as “8” or “9”), make sure to include the prefix in this field along with the
phone number.

Modem: [*Default:Hayes (unreliable transfers)]
Specifies the modem type.  If your modem is listed among those available, select it.  If not, select
*Default:Hayes (unreliable transfers).

Note: While the default modem functions in many cases, you may experience data corruption
when sending or receiving messages.  To configure Eudora for a reliable connection
using the default modem, you must modify the DEFAULT.MOD dialup file, as described
in Appendix E.

Baud rate: [9600]
Specifies the speed at which your modem communicates with the terminal server.  Select the value
that corresponds with your modem speed.

COM port: [COM2]
Specifies the COM port that your modem is connected to on your PC.

Flow Control: [Hardware]
Specifies the modem flow control.  Flow control is the ability of the modem and PC to stop the data
flow before the internal buffers fill up and overflow.  The modem may use either hardware or
software flow control (software flow control is typically the modem default setting), but hardware is
preferred and strongly recommended at baud rates above 9600.  If your modem does not support

QUALCOMM Incorporated 81



Reference Eudora User Manual

hardware flow control, then you must use software flow control.  Software flow control, however,
does not work well at speeds above 9600 baud.

Data bits: [8], Stop bits: [1], Parity: [none]
Specify various terminal server settings.  The default values are correct for almost all cases.  Consult
with your local Eudora support coordinator or service provider prior to changing any of these values.

Service provider: [*Default (must modify)]
Specifies the service provider whose terminal server Eudora is connecting to.  If your service
provider is listed among those available, select it.  If not, select *Default (must modify).

Note: The default service provider will not function until the SERIAL.NAV dialup file is
modified to work with your service provider, as described in Appendix E.

Dialup timeout after ? seconds [60]
Specifies the number of seconds before a dialup connection will time out.

Show trace window [on]
This option allows you to enable the Trace Window that Eudora displays when making dialup
connections.  When enabled, the Trace Window is opened automatically at the beginning of the
dialup session.  It follows what Eudora is sending, expecting, and the characters returned to Eudora.
The Trace Window is a valuable troubleshooting tool because when there is an error during the
dialup process, the window displays the source of the error.
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Advanced Network
These options control some of Eudora’s advanced network functions.  They should not be modified
without first consulting with your e-mail administrator.

The Advanced Network options

Use asynchronous Winsock calls for:
This option allows you to select asynchronous calls for Database functions or All others when
using the Winsock connection method. There are two methods of making Winsock calls using
TCP/IP stacks: blocking and asynchronous. Because of the ability to handle error conditions more
gracefully, asynchronous is the preferred method. However, some TCP/IP stacks do not handle
asynchronous calls correctly, so if you’re experiencing trouble with your Winsock connection make
sure both of these options are off.

Network Open timeout after ? seconds [60]
This option allows you to set the number of seconds before a network connection will time out.

Network timeout after ? seconds [60]
This option allows you to set the number of seconds before a network connection will time out.

Network buffer size of ? bytes [4096]
This option allows you to set the size of the buffer that Eudora uses to transfer information to and
from the server.

Note: If you are having trouble transferring large messages, the size of this buffer may be
decreased.

Cache network info [on]
This option causes Eudora to remember the results of previous database functions when using the
Winsock connection method.  This speeds up database functions within a single Eudora session.

Unload Winsock DLL after closing socket [off]
This option causes Eudora to unload the Winsock DLL after closing the socket. This is useful if you
don’t want Eudora to keep your Winsock DLL open continuously.

Automatically dial & hangup this connection [off] (32-bit Eudora only)
If this is checked, the specified dialup connection (referred to in Windows NT 4.0 as a “phonebook
entry”) is used when Eudora does any network operation. Use the popup menu to select a connection
in the Entry field.
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This option is only available if you have installed the dialup networking services with Windows 95
or Windows NT 4.0.

Username
This specifies the username for the auto connection.

Save password
If this is on, the auto connection password is saved in Eudora so that you do not have to re-enter it
after you exit and restart Eudora.

If you select Forget Password(s) from the Special menu, you will need to re-enter the password the
next time you check mail.
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MAPI
These options control the Eudora MAPI Server.

The MAPI options

Use Eudora MAPI server:  Never [default]
If this option is on, the Eudora MAPI server is off and is never automatically loaded.

Use Eudora MAPI server:  When Eudora is running
If this option is on, the Eudora MAPI server is on when Eudora is running.

Use Eudora MAPI server:  Always
If this option is on, the Eudora MAPI server is on and is always loaded on startup.

Delete MAPI attachments: Never
If this option is on, MAPI attachments are never deleted from the attachment directory.

Delete MAPI attachments: After sending messages
If this option is on, MAPI attachments are deleted from the attachment directory when their
corresponding messages are sent.

Delete MAPI attachments: When messages are emptied from trash [default]
If this option is on, MAPI attachments are deleted from the attachment directory when their
corresponding messages are emptied from the trash.
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Kerberos
These options control the Kerberos authentication system.  If your network uses Kerberos for
authentication, the appropriate options are provided by your e-mail administrator.

The Kerberos options

Kerberos POP3 port: [1110]
This is the port that the Kerberos POP server is listening on.

Realm: [none]
This is the network realm that the Kerberos server resides in.

Service name: [rcmd]
This is the type of service that you’re requesting.

Service format: [%1.%4@%3]
This is the name of the ticket that Eudora requests from the Kerberos server.
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Miscellaneous
The Miscellaneous Options determine miscellaneous Eudora functions.

The Miscellaneous Options

Switch messages with: Unmodified arrow keys [off]
If this is on and there is an incoming message window open on the screen, the up or left arrow key
opens the previous message and the down or right arrow key opens the next message. If this option is
off, the arrow keys can be used to move the caret in messages.

Note: Even if Unmodified arrow keys is on, the arrow keys do not switch messages if there
is an outgoing message topmost on the screen.

Ctrl+arrow keys [off]
If this is on, you can switch messages (as described in the “Unmodified arrow keys” section above)
by holding down the Ctrl key and pressing the arrow keys. The Ctrl+arrow keystrokes do not work
when composition windows are open on the screen.

Alt+arrow keys [on]
If this is on, you can switch messages (as described in the “Unmodified arrow keys” section above)
by holding down the [Alt] key and then pressing the arrow keys. The Alt+arrow keystrokes do work
when composition windows are open on the screen.

Require confirmation for deletes [on]
If this is on, Eudora alerts you when you are deleting messages you haven’t read or transferring
queued messages out of the Out mailbox.

Close messages with mailbox [off]
If this is on, closing any mailbox window (except Out) closes all the open messages from that
mailbox.

Empty Trash when exiting [on]
If this is on, the Trash mailbox is emptied when you exit Eudora. If this is off, the Trash is only
emptied when you select Empty Trash from the Special menu.

Say OK to alerts after ? seconds [on, 120]
If this is on, notifications of network problems automatically go away after the specified number of
seconds. This allows Eudora to try the communication again, and is most useful if you have
automatic mail checking enabled for any of your accounts.
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Turbo redirect by default [off]
If this is on and you select Redirect To, a redirected message is created with the specified recipient,
the message is queued, and the original message is deleted.

Automatically open next message [off]
If this is on, deleting or transferring the current message opens the next message in the mailbox, but
only if it is unread.

Allow Drag and Drop Transfers [on]
If this is on, you can transfer a message to another mailbox using drag and drop.

Intercept Netscape mailto URLs [off]
If this is on, Netscape mailto commands (clicking on an active e-mail address in a Web page) opens
a Eudora message.
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Menu Commands
The following sections describe each of the Eudora menu commands.

File
This menu provides basic file and mail functions.

New Text File
Create a new text file.

Open Text file...
Open a selected (highlighted) message summary, or text file.

Open Attachment
Open a selected (highlighted) message summary, an
attachment, or a mailbox (from the Mailboxes window).

Close
Close the current window.

Save
Save the changes to the topmost window.

Save As...
Save the current messages to a text file.

Send Queued Messages
Send all messages that have been queued for delivery.

Check Mail
Pick up new mail from the POP server.

Print...
Print the current message(s), or window.

Print Preview
Display the Print Preview window.

Print Setup ...
Display the Print Setup window.

Exit
Exit the Eudora application.
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Edit
This menu provides text editing tools.

Undo
Reverse the last action taken.

Cut
Delete the selected text and place it on clipboard.

Copy
Copy the selected text and place it on clipboard.

Paste
Paste the contents of the clipboard.

Paste as Quotation
Paste the contents of the clipboard as quoted text.

Clear
Delete the selected text.

Select All
Select the entire contents of a message or a mailbox.

Wrap Selection
Insert carriage returns into the selection, as appropriate.

Finish Address Book Entry
Complete the partial text of an Address Book entry’s
nickname.

Insert Recipient
Insert the chosen recipient.

Find submenu
Search for the designated character string.

Sort submenu
Sort the message summaries in a mailbox in ascending order.

Message Plugins submenu
Use Message Plugins.

Mailbox
This menu lets you open a mailbox, or bring an open mailbox to the front.

In
Open the mailbox where incoming messages are stored until
deleted or transferred to another mailbox.

Out
Open the mailbox where messages you compose are stored,
where queued messages are held until actually sent, and
where copies of sent messages may be initially stored.

Trash
Open the mailbox where deleted messages are stored.

New...
Display the New Mailbox dialog to create a new mailbox.

[Your Mailboxes]
Open the selected mailbox that you have created.

90 QUALCOMM Incorporated



Eudora User Manual Reference

Message
This menu lets you create, send, and delete messages.

New Message
Open a new message composition window.

Reply
Reply to the sender of the current message.

Reply to All
Reply to all the original recipients.

Forward
Forward the current message to someone else.

Redirect
Redirect the current message to someone else.

Send Again
Resend a message rejected by the mail system.

New Message To
Send a message to someone on the Quick Recipient list.

Forward To
Forward a message to someone on the Quick Recipient list.

Redirect To
Redirect the message to someone on the Quick Recipient
List.

Attach File [to New Message]...
Attach a file to the current message or open a new message
with the file attached.

Send Immediately or Queue For Delivery
Send the message or put it in the queue.

Change
Change the queueing, status, or priority.

Delete
Transfer the current message into the Trash mailbox.
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Transfer
This menu lets you transfer current message(s) to another mailbox.

In
Transfer the current message(s) to the In mailbox.

Out
Transfer the current message(s) to the Out mailbox.

Trash
Transfer the current message(s) to the Trash mailbox.

New...
Display the New Mailbox dialog to create a new mailbox;
current message(s) may be transferred into that mailbox.

[Your Mailboxes]
Transfer the current message(s) to the selected mailbox that
you have created.

Special
This menu lets you use additional Eudora functions.

Filter Messages
Run the manual filters for the current message(s).

Make Address Book Entry...
Create an Address Book entry from the current message.

Add As Recipient
Add selected text to the Quick Recipient list.

Remove Recipient
Select a recipient from this menu and the recipient is removed
from the Quick Recipient list.

Empty Trash
Delete all messages from the Trash mailbox.

Compact Mailboxes
Reclaim unused space in all mailboxes.

Forget Password
Make Eudora forget your password so mail can’t be checked.

Change Password...
Change your POP account password on the POP server.

Message Plugins Settings...
Open the Message Plugins Settings.
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Tools
All the Eudora Tools are listed in this menu.  Select one to open it.

Filters
Display the Filters window.

View Mailboxes
Display the Mailboxes window.

Address Book
Display the Address Book window.

Directory Services
Display the Directory Services window.

Signatures
Select a Signature to display the signature window.

Options...
Display the Options dialog.

Window
All standard Window options are listed in this menu, including what Eudora windows you have open.

Cascade
Cascade open windows.

Tile Horizontal
Tile open windows horizontally.

Tile Vertical
Tile open windows vertically.

Arrange Icons
Arrange all icons at the bottom of the main window.

Send to Back
Send the topmost window to the back of all displayed
windows.

[Your Windows]
All Eudora windows that are open are displayed here.
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Help
The Eudora Help menu and About Eudora screen are listed in this menu.

Topics
Display the on-line Help contents.

Context Sensitive Help
Display context sensitive Help.

About Eudora Pro
Display information about the Eudora Pro software.

Register Eudora
Register your copy of Eudora.

Insert System Configuration
Insert text with your system configuration
information.

About Eudora...
Display the About Eudora screen.

About Eudora Pro
All of the information about Eudora Pro is listed in this menu.

About Eudora Pro
Display information about the Eudora Pro software.

Request More Info
Create an outgoing message requesting information
about Eudora.

Request Ordering Program
Create an outgoing message requesting the Buy
Eudora application (it will be mailed back to you).

Remove This Menu
Remove the About Eudora Pro menu from the
application.
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Mail Storage
When you install Eudora, it creates a number of files within the assigned directory.  In addition,
Eudora creates additional files as needed for mailboxes, signatures, and other functions. The Eudora
files are described below.

eudora.ini
Your Options information is saved in the eudora.ini file, along with other information.  This file
contains notes that describe each entry.

nndbase.txt
Your nicknames are saved in the nndbase.txt file.

nndbase.toc
This file is the table of contents for your nicknames.

in.mbx, out.mbx, trash.mbx
These files hold your mail.  You’ll see files like these for every mailbox you create.

Note: These files are in UNIX mail format.

in.toc, out.toc, trash.toc
These files are the tables of contents for your mailboxes.  They make it much faster for Eudora to
access your mail.  You’ll see files like these for every mailbox you create.

lmos.dat
This file contains information about the messages on your mail server.

eudora.log, eudorlog.old
Eudora can keep records of all mail transfers.  These records are kept in the eudora.log and
eudorlog.old files.  The eudorlog.old file is overwritten and a new eudora.log file is created when the
eudora.log file reaches its approximately 100K maximum size.  To enable logging, set the LogLevel
entry in the [Debug] section of the EUDORA.INI file (for more information, see the [Debug] section
of the EUDORA.INI Settings File On-line Help).

filters.pce
Eudora filter names and extensions are saved in the filters.pce file.

descmap.pce
Mappings between mailbox names and DOS 8.3 file names are stored in the descmap.pce file.

*.tlx
Dictionary information is stored in the .tlx files.

Sigs Directory
The Standard and Alternate signature files are kept in the Sigs directory.

Plugins Directory
The EMSAPI plugins are kept in the Plugins directory.
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Anonymous ftp (ftp.qualcomm.com)
QUALCOMM has an anonymous ftp server (ftp.qualcomm.com) that has information and software
related to Eudora. These are located within the “quest” directory. Included are POP3, Ph, and
password changing servers, the srialpop program, current product information, dialup files, and
more.

Eudora Information
The information in this manual was correct at the time of printing. However, things happen very
quickly in the electronic world, meaning that some of this information may already be out of date.
For the very latest information about Eudora, send e-mail to eudora-info@qualcomm.com.

Obtaining a POP Server
If you would like to run a POP server on your own UNIX system, we suggest you use “popper.”
Popper is available via anonymous ftp from ftp.qualcomm.com. Popper versions are available for a
number of UNIX systems.

VAX/VMS systems may try the “Multinet” package from TGV, or IUPOP3, available via
anonymous ftp from ftp.indiana.edu.

For VM/CMS users, there is a port of “popper” available via anonymous ftp from vmd.cso.uiuc.edu
(cd to the “POPD” directory).

Ph Server Source Code
A server for the “Ph” protocol is available via anonymous ftp from ftp.qualcomm.com.

Password Change Server
Three sample UNIX servers for Eudora’s “Change Password” command are available via
anonymous ftp from ftp.qualcomm.com.

Windows Sockets Products
Demos of Windows Sockets 1.1 compliant stacks and applications are available via anonymous ftp
from papa.indstate.edu in the directory winsock-l.  The are also available on ftp.cica.indiana.edu in
the directory pub/pc/win3/winsock.

For those with World Wide Web (WWW) browsers, try the following sites:

The Consumate Winsock Applications list: http://www.cwsapps.com/
The Ultimate Collection of Winsock Software: http://www.tucows.com/
Stardust Technologies: http://www.stardust.com/wsd/
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PC Speaker
If you want the new mail sound notification to work with the speaker that comes with your PC, you
need to install the PC speaker driver.  This driver is available via anonymous ftp from
ftp.qualcomm.com.  It’s the file SPEAK.EXE in the directory quest/windows/eudora/utils.  This is a
self-extracting archive, so just run it on your PC to produce the necessary files and instructions.

Note: The PC speaker driver does not work with Windows 95 or Windows NT.

Kerberos
You can get the necessary files and information for setting up Kerberos authentication in Eudora
from ftp.qualcomm.com in the directory quest/windows/kerberos.  Be sure to read the installation
instructions to insure that Kerberos is set up properly.

To learn more about the Kerberos authentication system, anonymous ftp to athena-dist.mit.edu and
begin in the pub/kerberos directory.
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Modifiers
Many operations in Eudora can be implemented by holding down one or more “modifier” keys.
Eudora uses the Shift, Ctrl, and Alt keys as modifiers.

Shift + Queue/Send Open the Change Queuing dialog.

Shift + Insert Recipient Insert the address(es) instead of the nickname.

Shift + Finish Address Book Entry
Finish the Address Book entry with the address(es) instead of the
nickname.

Shift + Sort command Sort in descending order.

Shift + Transfer Put a copy of the current message in the selected mailbox and
leave the original where it is.

Shift + Copy Copies the selected text without the carriage returns (copy
unwrapped).

Shift + Wrap Selection Removes the carriage returns from the selected text (unwraps).

Shift + Save Saves changes to all open windows.

Shift + Close Closes all open windows.

Shift + Exit Sets all open windows to open again when Eudora is next started.

QUALCOMM Incorporated 99



Appendix B – Modifiers and Shortcuts Eudora User Manual

Shortcuts
The shortcuts for Eudora functions are as follows:

Ctrl + 0 Open Out mailbox Ctrl + M Check mail

Ctrl + 1 Open In mailbox Ctrl + N New message

Ctrl + ' Paste as quotation Ctrl + O Open file

Ctrl + ; Find next Ctrl + P Print

Ctrl + A Select all Ctrl + Q Exit Eudora

Ctrl + C Copy to clipboard Ctrl + R Reply

Ctrl + D Delete Ctrl + S Save current window

Ctrl + E Send or Queue Ctrl + T Send queued messages

Ctrl + F Find window Ctrl + V Paste from clipboard

Ctrl + G Find again Ctrl + W Close message

Ctrl + H Attach document Ctrl + X Cut to clipboard

Ctrl + J Filter messages Ctrl + Y Directory Services

Ctrl + K Make Address Book entry Ctrl + Z Undo

Ctrl + L Open Address Book

arrows Move from one message to another in a mailbox (depends on your
Miscellaneous Options).

enter Select the outlined button in any dialog, alert, or window, or open the
selected messages.

esc Stop any operation currently in progress.

F1 Eudora Help.

F2 Rename the selected item in Mailboxes or Address Book.*

F3 Find again.

F7 Toggle split windows in Composition and Address Book.*

page up, page down Scroll up or down through the window.

* 32-bit version only
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Introduction
Eudora uses Simple Mail Transfer Protocol (SMTP) to transfer your outgoing mail to your SMTP
server machine, which in turn uses SMTP to send your mail to the world at large. Mail from the
world at large arrives on your Post Office Protocol (POP) server, where it waits for Eudora to pick it
up with POP version 3. The mail Eudora sends and receives is constructed in accordance with RFC
822 and RFC 1521 (MIME).

Your Macintosh POP/SMTP
Server

The World at Large

POP
Check Mail

SMTP
Send Queued Messages

SM
TP

Your PC
Check Mail

Send Queued Messages

Eudora mail transport overview

Outgoing Mail
When you send an e-mail message to someone, Eudora uses SMTP to send the mail to your local
SMTP server computer. That computer then sends the mail to your addressee’s computer, also
(usually) by means of the SMTP protocol.

Why doesn’t Eudora talk directly to your addressee’s computer? For one thing, it would take a lot
longer for your mail to leave your PC, because your PC would have to call up each addressee’s
computer and deliver your mail. For another, some computers are “hard to find;” it’s much better to
let another computer “hunt” for your addressee than to make your PC do it. Finally, sometimes your
addressee’s computers won’t be available when you want to send mail. The SMTP server handles
this by holding your mail until the other computer is ready to accept it, eliminating the
inconvenience of having unsent messages hanging around on your PC.
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Incoming Mail
When somebody sends you mail, other computers use the SMTP protocol to deliver the mail to your
POP server. Your POP server puts mail in your “mail drop,” where it stays until the Eudora program
picks it up. When you check your mail, Eudora uses POP version 3 to pick up your mail and move it
to your PC.

Why doesn’t Eudora use SMTP to receive your mail? SMTP works best when the computers it
knows about are always ready for mail. Unless you wanted to run Eudora 24 hours per day, seven
days a week, SMTP wouldn’t work very well for you. It also doesn’t work well in lab environments,
where you might use any number of different PCs.

More Information
If you want to know more about the Internet in general, consult the book Internetworking with
TCP/IP, by Douglas Comer, 1988, Prentice-Hall ISBN 0-13-470154-2 025.

If you want to know more about SMTP, RFC 822, POP version 3 and MIME, the official standards
are:

RFC 821, “Simple Mail Transfer Protocol,” by Jonathan B. Postel

RFC 822, “Standard for the Format of Internet Text Messages,” by Dave Crockeb

RFC 1939, “Post Office Protocol, Version 3,” by Marshall Rose

RFC 1521, “Multipurpose Internet Mail Extensions,” by Ned Freed and Nathaniel Borenstein

You can find the RFCs by anonymous ftp to nic.ddn.mil; see Internetworking with TCP/IP for
details.
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What is MIME?
“MIME” stands for Multipurpose Internet Mail Extensions.  MIME serves two major purposes – it
allows mail applications to tell one another what sort of data is in mail, and it also provides standard
ways for mail applications to encode data so that it can be sent through the Internet mail system.

MIME Encoding
The Internet uses the “SMTP” protocol to move mail around.  SMTP is limited to the US-ASCII
character set (see Appendix C).  This is a problem for people who speak languages other than
American English and so need accented characters or non-American letters, or for people who want
to use special symbols like the bullet.

MIME provides a way around this restriction.  It offers two encodings, “quoted-printable” and
“base64.”  These encodings use US-ASCII character codes to represent any sort of data you like,
including special characters or even non-text data.

Quoted-printable is used for data that is mostly text, but has special characters or very long lines.
Quoted-printable looks just like regular text, except when a special character is used.  The special
character is replaced with an “=” and two more characters that represent the character code of the
special character.  So, a bullet in quoted-printable looks like “=95.”

However, there are some other things that quoted-printable does.  For one, since it uses an “=” to
mean something special, equal signs must themselves be encoded (as “=3D”).  Second, no line in
quoted-printable is allowed to be more than 76 characters long.  If your mail has a line longer than
76 characters, the quoted-printable encoding will break your line in two, and put an “=” at the end of
the first line, to signal to the mail reader at the other end that the two lines are really supposed to be
one.  Finally, a few mail systems either add or remove spaces from the ends of lines.  So, in quoted-
printable, any space at the end of a line gets encoded (as “=20”) to protect it from such mail systems.

Let’s try an example.  Here’s a passage of text that you might type on your PC:

«Il est démontré, disait-il, que les choses ne peuvent être autrement; car tout étant fait pour une

fin, tout est nécessairement pour la meilleure fin.»

Without any encoding, this might show up on your recipient’s screen as:

+Il est dimontri, disait-il, que les choses ne peuvent btre autrement; car tout itant fait pour une

fin, tout est nicessairement pour la meilleure fin.;

This corruption happens because SMTP cannot handle the special characters.  However, if you and
your recipient both have MIME, quoted-printable encoding would be used, and your text would
show up properly:

«Il est démontré, disait-il, que les choses ne peuvent être autrement; car tout étant fait pour une

fin, tout est nécessairement pour la meilleure fin.»
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While your mail was actually in transit, however, it would have looked like:

=ABIl est d=E9montr=E9, disait-il, que les choses ne peuvent =EAtre =

autrement; car tout =E9tant fait pour une fin, tout est n=E9cessairement =

pour la meilleure fin.=BB

Base64 encoding is another way to protect binary data from the SMTP mail system.  However,
Base64 makes no attempt to be legible, and is most appropriate for non-text data.

MIME Labelling
The other important part of MIME is that it lets mailers communicate what kind of data is in a
message (or part of a message).  The primary mechanism used for this is the Content-Type header:

Content-Type: text/plain; charset=iso-8859-1

A content-type header is divided into three parts; the content type, the content subtype, and the
parameters.  In this case, the content type is “text,” meaning the message contains mostly legible
text.  The content subtype is “plain,” which means there aren’t any formatting commands or
anything like that embedded in the text.  Finally, “charset=iso-8859-1” is a parameter; in this case, it
identifies the character set the message uses.

The major content types are:

text legible text
image pictures and graphics
audio sound
video moving pictures
message messages or pieces of messages
multipart several different kinds of data in a single message

Practical Issues
There are really only two things you sometimes need to do with Eudora and MIME.  One is that it
may occasionally be necessary to turn off quoted-printable encoding.  Another is that you may want
to know how to define mappings between PC file extensions, MIME types, and Macintosh types.

Turning Off Quoted-Printable Encoding
Eudora automatically uses quoted-printable encoding if your mail contains special characters.
Eudora also uses quoted-printable encoding for attached plain text files.  If your recipients don’t
have MIME, quoted-printable may hurt more than it helps.  If that’s the case, just turn off the QP
button in the message Toolbar when you are sending text files to those recipients.

Mapping Between File Extensions, MIME Types, and Macintosh Types
Since Eudora needs to have the appropriate extensions on attachment filenames in order to open
them up from the message, Eudora has the ability to map between file extensions, MIME types and
subtypes, and Macintosh creators and types.  Messages received by Eudora can grab the MIME
type/subtype and/or Macintosh creator/type from an attachment and map that into the correct file
extension.  Also, on outgoing messages, Eudora can make sure that attachments are encoded with the
correct MIME type/subtype and/or Macintosh creator/type depending on the file extension of the
attachment being sent.

Eudora knows about some MIME types.  However, since new MIME types are being defined all the
time, it may be necessary to add to Eudora’s knowledge from time to time.  Adding new mappings

104 QUALCOMM Incorporated



Eudora User Manual Appendix D – MIME and Mapping

between the various types only requires editing the EUDORA.INI file with a text editor (like the one
that comes with Eudora).

There is a section in the EUDORA.INI file labelled [Mappings], followed by some entries, one per
line.  Each entry is called a map.  A map defines when the mapping should occur (which can be “in,”
“out,” or “both”), followed by an equal sign and five parameters.  These five parameters are (in
order) the PC file extension, the Macintosh creator code, the Macintosh type, the MIME type, and
the MIME subtype.  Here are some sample entries:

[Mappings]

both=gif,,,image,gif

both=mpg,,,video,mpeg

both=doc,MSWD,,,

in=xls,XCEL,,,

out=xls,XCEL,XLS4,,

both=eps,,EPSF,application,postscript

A map marked “in” only tries to match the map to messages that you receive.  A map marked “out”
only tries to match the map to messages that you send.  A map marked “both” tries to match the map
to both incoming and outgoing messages.

The first map above says that any incoming MIME message that has a part type of “image” and
subtype of “gif” will get saved to a file with the extension “.gif.”  It also specifies that outgoing
messages that have an attachment with the file extension “.gif” will get the MIME type of “image”
and subtype of “gif” if the encoding method of the message is MIME.  The second map is similar to
the first map in structure, but uses a different file extension and MIME type and subtype.

You can use map entries to move between PC file extensions and Macintosh creator and type as
well.  The third map says that if an incoming message has an attachment with the Macintosh creator
“MSWD” (which is the Macintosh creator for Microsoft Word) then the file extension of the
attachment when saved to disk should be “.doc” (the file extension that Word for Windows uses).
Since the map is marked as “both,” it will also give attachments with the extension “.doc” on
outgoing messages the Macintosh creator of “MSWD” if the encoding method of the message is
BinHex.

Note that the Macintosh type from this map is empty.  This allows multiple types to be recognized
with just one mapping.  This is nice for “in” maps because it allows you to cover a range of
creator/type pairs with one map.  You must be careful in using this type of map with an “out” or
“both” mapping, though, because an outgoing attachment that matched this map would have a
Macintosh creator, but no Macintosh type.  Some Macintosh applications cannot open files with a
missing type.  Microsoft Word for the Macintosh can open files without a type, so this map is fine
being marked “both.”

Microsoft Excel for the Macintosh is an example of a program that can't open a file with an empty
type.  This is why there are two maps for Excel (the fourth and fifth maps above).  The incoming
map for Excel is like the one for Microsoft Word, but the outgoing map explicitly defines the
Macintosh type.

The last map shows that you can have both Macintosh creator/type and MIME type/subtype in one
entry.  This map says that if an incoming message has an attachment that is encoded in MIME and
has the “application/postscript” type/subtype, or has a BinHex attachment with the Macintosh type
of “EPSF,” then the resulting file will have an extension of “.eps.”  Similarly, if an outgoing message
has an attachment with the extension “.eps” and if the MIME encoding is being used for the
message, then the attachment will get the “application/postscript” MIME type/subtype.  If the
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message was using the BinHex encoding, then the attachment would get the Macintosh type of
“EPSF.”

But what happens if an attachment matches more than one map?  Eudora will try and find the best
match.  For example, if you had the following [Mappings] section:

[Mappings]

in=xls,XCEL,,,

in=xlc,XCEL,XLC3,,

and you received a message with an attachment that had a Macintosh creator of “XCEL” and a
Macintosh type of “XLC3” (a Microsoft Excel Chart), then the file would get an extension of “.xlc”
since the first map only matched the Macintosh creator, but the second map matched both the
Macintosh creator and type.

Eudora can receive attachments that have both a MIME type/subtype and a Macintosh creator/type.
Eudora understands attachments with the MIME type/subtype “application/applefile,” which has
Macintosh creator/type information embedded in it.  With this type of attachment, Eudora will
consider a match with the Macintosh creator/type as a “better” match than a match with the MIME
type/subtype.

Finally, if an incoming attachment matches two different maps to the same degree (e.g., both maps
have the same MIME type/subtype with different file extensions), then Eudora will use the file
extension in the first matching map.
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Introduction
The Dialup connection method is only for users with a Unix shell account. Most users have SLIP,
PPP, or direct network connections and can use the Winsock connection method.

Eudora is capable of dialing into systems such as Cisco and Annex terminal servers and UNIX and
VMS systems for the purposes of sending and receiving mail messages and making Ph and Finger
inquiries.  Dialup Eudora utilizes a serial connection that relies on error correcting modems and
proper modem and serial port configurations to create a reliable link.  This facility is not to be
confused with dialup connections such as SLIP and PPP, which provide reliable network
connections.

This appendix outlines the IBM PC/Modem and dialup connection requirements for establishing a
serial dialup link between Eudora and your mail server.  It includes descriptions of the dialup files
Eudora runs when establishing this connection, along with instructions for creating your own dialup
files by modifying the default files installed with the Eudora software.  These instructions assume
you are familiar with a text editor, your PC, your modem equipment, and your Internet service
provider and/or POP/SMTP hosts.

Note: It is recommended that one person create the dialup files for Eudora and then
redistribute the customized files to other users at your site.

IBM PC/Modem Requirements
To use Eudora over a dialup connection, you should have a modem which supports the Microcom
Networking Protocol version 4 (MNP4) or the Link Access Protocol for Modems (V.42).  If you are
using an external modem you must have a straight through cable (with a minimum of 8 signals for
TX, RX, RTS, CTS, DCD, DTR, DSR, and GND).  A communications card with 16550 UARTS is
also recommended for communication speeds over 9600 baud.

Dialup Connection Requirements
Eudora needs a “transparent” and “reliable” connection to your POP, SMTP, and other servers.

Transparent means primarily two things:

1. Characters Eudora sends should NOT be echoed back to Eudora.  Most systems do echo
characters, so something special may need to be done to achieve this (see the “Echo
Canceling” section).

2. You must pay close attention to how carriage returns are treated.  Telnet programs routinely
translate carriage returns into carriage return (cr)/ linefeed (lf) pairs.  For this reason, Eudora
processes cr/lf pairs to plain carriage returns by default.  If your system does not translate
carriage returns to cr/lf pairs, or you are running srialpop to establish an echoless session,
Eudora’s cr/lf processing must be disabled.  This can be done by entering the “set
CRLFProcessing=0” command in the DEFAULT.NAV file or by unchecking the CRLF
Processing option in the Options dialog (Dialup).

Reliable means that the modem you are using supports flow control (hardware RTS/CTS is
recommended) and either MNP4 or V.42 for a reliable modem to modem connection.
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Dialup Files
Eudora uses a rudimentary command language stored in specific text files to tell it how to dial into
and back out of the mail server.  These text files are called “dialup” files.  The dialup files are placed
in a Scripts directory within your Eudora directory when you install Eudora.  You select which
modem and navigation (Service provider) file to use in the Options dialog (Dialup).  However, if
your modem and/or service provider are not supported, you should use the Default files.  These files
must then be modified to work with your modem/service provider, as described in the “Creating
Your Own Dialup Files” section.

There are four dialup files associated with Eudora.  The first file (DEFAULT.MOD) contains the
modem configuration commands; the second file (DEFAULT.NAV) contains the dialing and
navigation commands along with the appropriate telnet command (and the srialpop command, if
necessary); the third file (DEFAULT.MID) contains the prompt locating commands; and the fourth
file (DEFAULT.END) is used to hang up the modem.  The first three dialup files must exist or an
error dialog will appear.  The DEFAULT.END file is usually not necessary.

Eudora starts off the dialing process by interpreting the DEFAULT.MOD file.  The commands in
this file configure the modem.

The DEFAULT.NAV file then takes over to dial the phone number and run commands to reach the
terminal server/system user prompt.  After reaching the user prompt, the telnet command is run.  The
telnet command accesses the service being used and, in some cases, establishes the echoless session
required by Eudora.  In those cases where the telnet command does not disable echo, the srialpop
command should be run.

Once the network service is no longer required, the DEFAULT.MID file is executed to reacquire the
user prompt.  Eudora is then free to close down the connection or acquire another service.

In closing down the dialup connection, Eudora drops the Data Transfer Ready (DTR) signal, which
resets a properly configured modem.  Eudora also has the option of interpreting commands in the
DEFAULT.END file to place the modem on hook and/or any other action.

Note: The execution during the dialup connection may be terminated at any time by clicking
the Stop button in the progress window or typing [Esc].

All the dialup files are checked for syntax and variable replacement before the dialup takes place.  If
a syntax error occurs a dialog appears to notify the user of the navigation file name and line number.
The navigation file commands themselves are described in the “Dialup File Command Lines”
section.

Creating Your Own Dialup Files
The appropriate dialup files may have been installed in the Scripts directory within your Eudora
directory when you installed Eudora.  However, if your modem and/or Internet service provider were
not included in the installation, you were instructed to install the “default” files (if this happens,
please let us know so that we can include your modem and service provider in a future revision).
This section outlines the steps you should take to modify the default files to work with your
modem/service provider.

To edit any of the four dialup files, simply use a text editor (one is provided within Eudora).

DEFAULT.MOD File
This dialup file is responsible for configuring your modem.  The default DEFAULT.MOD file
contains general modem configuration commands that all Hayes-compatible modems will respond
to.  It also contains comments describing the dialup Eudora requirements that need to be met in order
to guarantee a stable connection between your PC and modem, and your modem and server.
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Note: If these dialup Eudora requirements are not met, Eudora may still work, but you may
experience data corruption when sending or receiving messages.

There are five commands that need to be entered into the DEFAULT.MOD file to meet the Eudora
dialup requirements.  The modem commands are defined in the commands section of your modem
reference guide.  Enter these five commands as follows:

Note: An explicit “\r” must be placed at the end of each send line if you wish to terminate
the line.

1. Enter the command that configures your modem to respond to DTR.  When DTR is dropped
the modem should reset, drop carrier, and go into command mode.  Typically, the modem
defaults to ignore DTR.  A Hayes-compatible modem uses the command “AT &D2” to
configure it to respond to DTR.

EXAMPLE:  send AT &D2\r

2. Enter the command that configures your modem for reliable operation (MNP4 or V.42).  If
you do not use a reliable mode you risk dropping/altering characters, thus corrupting
incoming as well as outgoing messages.  Typically, the appropriate command can be found
in the \N section of the modem manual (e.g., \N2).

EXAMPLE:  send AT \N2\r

Note: Some Internet service providers do not support both V.42 and MNP4.  If this
is the case with your service provider, find out which reliable mode is
supported and then configure your modem accordingly.  If you cannot match
your modem to your service provider (e.g., your modem supports only V.42
and your service provider supports only MNP4), you may need to disable
reliable mode and sacrifice your data integrity.

3. If your modem supports hardware flow control, enter the command that configures your
modem for hardware flow control.  Flow control is the ability of the modem and PC to stop
the data flow before the internal buffers fill up and overflow.  The modem may use either
hardware or software flow control (software flow control is typically the modem default
setting), but hardware is preferred and is strongly recommended at baud rates above 9600.
Typical hardware flow control commands are *FL, \Q,  and &K.

EXAMPLE:  send AT *FL\r

If your modem does not support hardware flow control, then you must use software flow
control.  Software flow control, however, does not work well at speeds above 9600 baud.

Note: Hardware flow control uses the RTS and CTS signals on the RS-232 cable.
The PC and modem can react to these signals much faster than software flow
control, which uses a character to stop and a character to start the
transmission of characters.

4. If you have set your modem to support hardware flow control (as described in step 3),
change the command that sets the Eudora FlowControl variable to Hardware (i.e., “set
FlowControl=Hardware”).  This command overrides the FlowControl value in the [Dialup]
section of the EUDORA.INI file (this feature is only available in version 2.0.2 or later).

Note: The flow control options for the modem and Eudora must match or you will
experience data corruption and/or communication failures.  The “set
FlowControl=Software” command was inserted into this file so that Eudora
matches the default setting of the modem if you do not change it to hardware.

5. Enter the command that fixes the modem baud rate.  Many modems adjust the speed to the
line speed after the carrier is established.  You do not want the modem to change the speed
that the PC is expecting.  Typical commands are \J0, B0, and \B0.
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EXAMPLE:  send AT \J0\r

Note: Sometimes just selecting hardware flow control will disable baud rate adjust.

DEFAULT.NAV File
This dialup file is responsible for dialing the phone number (via the {DialNumber} variable) and
navigating to the system prompt of your system/terminal server.  In addition to the DEFAULT.NAV
files installed with Eudora, some Internet service providers and system administrators have
developed DEFAULT.NAV files that work with Eudora.  Contact your Internet service provider or
system administrator and ask if they have a navigation script that works with Eudora.  If not, it will
be necessary to edit the default DEFAULT.NAV file to match the login requirements of your
particular Internet service provider.

Note: Prior to editing the default DEFAULT.NAV file you will need to be familiar with all
of the available commands and variables.  These are defined in the “Dialup File
Command Lines” section of this appendix.

The default DEFAULT.NAV file contains a generic dialup script.  Prior to editing this script, you
will need to know the navigation sequence for getting to the host system prompt.  You can
accomplish this by dialing into the host system using a standard terminal program that saves your
login session, such as the one that comes with Windows (“Terminal”).  This will tell you what
prompts to expect from the system and what commands to send it.  Using the commands and
variables at your disposal, edit the navigation sequence accordingly.

Note: An example dialup session and the resulting navigation sequence are provided in the
default DEFAULT.NAV file.

Telnet Command
Once you have edited the navigation sequence of this file, enter the appropriate telnet command or
activate one of the three telnet commands that are provided in this file (to activate a command,
simply remove the comment character at the beginning of the command line).  The telnet command
is required to access the network services once you have logged into your terminal server or system.

Prior to entering/activating the telnet command you will need to know the following:

• Are you logging into a terminal server or UNIX system?

• If logging into a terminal server, what type is it?

• Do you need to run srialpop on the host to establish an echoless connection?

Telnet commands are provided for Annex and Cisco terminal servers.  These commands establish
the echoless telnet session required by Eudora.

Note: The active telnet command in this dialup file will override the default Eudora telnet
command or an existing telnet command in the [Dialup] section of the EUDORA.INI
file (this feature is only available in version 2.0.2 or later).  See the “EUDORA.INI
[Dialup] Settings” section for information on the default telnet command.

An additional telnet command is provided if you are dialing directly into a UNIX system (that is,
you get a system prompt instead of a terminal server prompt).  This command works in conjunction
with the srialpop command to establish an echoless telnet session.  Srialpop runs on the UNIX host
computer.  A source copy of this program (srialpop.sh) was placed in your Eudora directory as part
of the installation process.

If you are using this telnet command (or any other telnet command that does not disable echo),
activate the “set CRLFProcessing=0,” “send exec srialpop\r” and “waitfor %” commands by
removing the comment character at the beginning of each command line.  This will run srialpop on
the host computer and provide for an echoless session.
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If you are connecting to a terminal server that is not supported by one of the provided telnet
commands, contact your service provider or system administrator to obtain a telnet command that
provides an echoless session.  If it does not disable echo, then enter it after the srialpop command
lines and be sure to activate them.

Note: If you enter a different telnet command in this file, be sure to place a “\” character
directly before the beginning “{“ character in a variable field.  For example, “set
TelnetCommand=stty -echo\ntelnet -r \{System} \{Port}\n.”

DEFAULT.MID
This dialup file simply waits for the terminal server/system prompt.  The waitfor command in this
file should match the waitfor command at the end of the navigation sequence in the DEFAULT.NAV
file.

EXAMPLE:  waitfor %

DEFAULT.END
This dialup file is normally not required (and may be deleted).  It is responsible for resetting the
modem if DTR will not.  This file contains the standard modem hangup and reset commands for
Hayes-compatible modems.

Dialup File Command Lines
The Eudora dialup files are simple text files that can be edited using any text editor (the one provided
within Eudora, for example).  The command lines themselves are made up of commands, character
sequences, delimiters, text string variables, and special characters.  These elements are defined
below.

Note: Command lines beginning with a ‘#’ or ‘;’ character are comment lines which are not
utilized as part of the file.  These may contain comments or help text supplied by the
script writer.  Blank lines are also treated as comment lines.

The maximum string length of a command line is 255 characters.  This is the same limit for the
string used after variables and special characters are replaced with the appropriate values.  Trailing
spaces are stripped unless the last space is escaped (i.e., preceded by a ‘\’ character), at which point
all trailing spaces up to that point are left in the translation string.  All variables and commands are
case-insensitive, so you may mix case as you see fit.  Character sequences may be case-sensitive,
however, depending on the system/terminal server you are connecting to.

Note: Command lines are not automatically terminated with a carriage return or new line,
you must add a ‘\n’ and/or ‘\r’ character to the end of any command line you wish to
end with [Enter] (see the “Special Characters” section).

Commands
The first word in each command line must be a command.  The following commands are defined for
use in the Eudora dialup files:

Note: In the examples below, the symbol <str> represents the character sequence (see the
“Character Sequences” section), the symbol <c> represents the delimiter character
(see the “Delimiters” section), the symbol <setting> represents any of the
EUDORA.INI [Dialup] settings (see the “EUDORA.INI [Dialup] Settings” section),
and the symbol <sec> represents a value in seconds (e.g., 60).

send <str> Send the character sequence out the serial port.  All input waiting in the
serial receive buffer is purged.

waitfor <str> Do not continue the file until the character sequence is matched.  Multiple
sequences may be searched if a delimiter is used; however, the delimiter
must be used at the beginning of the first sequence and the end of the last
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sequence.  For example, waitfor <c><str><c><str1><c> <str2><c>
allows you to wait for one of three matches.  Any non alpha-numeric
character may be used as a delimiter (see the “Delimiters” section).

cancelon <str> If, while executing a waitfor, this character sequence is matched, the file
is aborted with an error.  Multiple matching may occur if a delimiter is
used, as described in the waitfor command.

set <setting>=<str> This command can be used to override one of the [Dialup] settings in the
EUDORA.INI file (an example of this is the “set FlowControl=Hardware”
command in the DEFAULT.MOD file).

pause <sec> Wait the specified number of seconds before interpreting the next
command.

sendbreak Send a break signal to the modem.

sendprompt <str> Prompt the user for input required by the service provider/system that is
not a fixed value (such as a timed password).  You are then prompted to
enter a string that will be sent out to the serial port (with an optional \r\n
on the end).

timeout <sec> Set the waitfor timeout to be a specified number of seconds.  Shorter
timeouts are useful for modem commands, longer ones for waiting for
carrier.

Character Sequences
Command line character sequences can be made up of any characters.  However, special care must
be taken with the characters ‘{’, ‘}’, and ‘\’, which are used to designate variables and special
characters.  When used in character strings, these characters must be preceded with a ‘\’ (i.e., ‘\{’,
‘\}’, ‘\\’).

Note: Character sequences may be case-sensitive, depending on the server being connected
to.

Delimiters
Delimiters are used to separate character sequences in command lines where more than one character
sequence is present.  Any non alpha-numeric character may be used as a delimiter.  The delimiter
serves the ‘or’ function when placed between character sequences.  Additionally, a delimiter must be
used at the beginning of the first sequence and the end of the last sequence.  For example, in the
command line cancelon |NO DIALTONE|BUSY|NO CARRIER|, the connection will be
canceled if any of three matches are found.

Variables
Although not required, predefined variables can be used in the dialup files.  They are enclosed in
curly brackets, that is, ‘{’ and ‘}’, when appearing on command lines.  The available variables are
defined below.

The following variables are set in the Eudora Configuration dialog with the exception of the
password variables, which are set in popup dialogs:

{DialNumber} Phone number configuration line.

{DialLogin} Commonly set with the terminal server user name.

{DialPass} Password associated with the {DialLogin} variable.

{POPLogin} User name in the POP account configuration line.

{POPPass} Password associated with the {POPLogin} variable.
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{POPHost} Host portion of the POP account configuration line.

{SMTPHost} SMTP host configuration line.

The following variables are derived from values in the Options dialog and can be used in the telnet
command:

{System} This is the system you are connecting to.

{Port} This is the port number of the host where the network service is located.

Special Characters
Special characters can appear at any place in the command line.  The available special characters are
defined below.

Note: Characters preceded with a '\' character that are not in the following list are simply
stripped of the '\'.

\n A linefeed (ASCII 10).

\r A carriage return (ASCII 13).

\0 - \7 An octal constant, usually one to three characters.

\\ A single backslash character.

When Eudora is communicating with your POP or SMTP server, it is important that they agree on
what constitutes a line.  The specifications for these two protocols stipulate that a line ends with a
carriage return (cr) followed by a linefeed (lf).  Most UNIX systems translate carriage returns into
cr/lf pairs.  For this reason, Eudora processes cr/lf pairs to plain carriage returns by default.  If your
system does not translate carriage returns to cr/lf pairs, or you are running srialpop to establish an
echoless session, Eudora’s cr/lf processing must be disabled.  This can be done by entering the “set
CRLFProcessing=0” command in the DEFAULT.NAV file or by editing the [Dialup] section of
EUDORA.INI file (refer to these sections for more details).

Echo Canceling
Echo can cause Eudora to become confused, reduce throughput, and cause data to be lost if buffers
fill up.  Therefore, disabling echo when using Eudora is very important.  If your PC has a serial line
to a UNIX machine, or if there are modems on your PC and UNIX machine, you can disable echo
using a number of methods, two which are described below.

Method 1 – The Telnet Command
Some terminal servers allow commands to be run that disable echo to be part of the telnet command.
For example, when connecting to an Annex terminal server the DEFAULT.NAV file uses the
following command line:

set TelnetCommand=stty -echo\ntelnet -r \{System} \{Port}\n

The “stty -echo” command turns off terminal server echo.

Note: When using this method, the DEFAULT.MID file should be configured to wait for the
system prompt.

Method 2 – Serial pop
1. Install the srialpop program onto your UNIX system.  Source to this is part of the Eudora

distribution.

2. Activate/place the following command lines in the DEFAULT.NAV file.

set CRLFProcessing=0
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send exec srialpop\r
waitfor %

Note: When using this method, use a “waitfor %” command in the DEFAULT.MID file.

Dialup File Troubleshooting
Eudora has a way to help users troubleshoot dialup files – the Trace Window.  This window follows
what Eudora is sending, expecting, and the characters returned to Eudora while it is waiting for a
pattern match.  This window is enabled in the Options dialog (Dialup).

When enabled, the Trace Window is opened automatically at the beginning of the dialup session.  If
there is an error during the dialup process, the window displays the source of the error.  You can then
explore the appropriate corrective action.

Example Trace Window

In addition to using the Trace Window when troubleshooting dialup Eudora, a few of the typical
problems encountered when attempting to connect to your terminal server/system for the first time
are described below (symptoms), along with the probable corrective action for each:

Symptom Corrective Action

Eudora times out at the telnet
command when sending or
checking mail (it has never
worked).

You may have a problem with carriage return
(cr)/linefeed (lf) processing.  By default,
Eudora converts cr/lf character pairs into cr.
This is because many telnet programs convert
cr into a cr/lf pair.  If your telnet program does
not convert cr to cr/lf, then you need to disable
the cr/lf processing done by Eudora.  To do
this, add the command “set
CRLFProcessing=0” to the beginning of the
navigation sequence in your DEFAULT.NAV
file.

Eudora has problems talking
to your modem at speeds
higher than 9600 baud, even
with hardware flow control.

Standard serial ports that come with most PCs
do not operate well above baud rates of 9600
baud.  You may need a high speed serial card
with 16550 UARTs.

Symptom Corrective Action
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Eudora can send small
messages but not large
messages.

Chances are you have not been successful in
disabling echo on your telnet session.  If echo
is not disabled, Eudora will get very confused.
Edit your DEFAULT.NAV file and enable the
commands that run srialpop (see the “Echo
Canceling” section).  This will establish the
echoless connection that Eudora requires.

Eudora can receive mail but
times out when sending mail,
even small messages.

Chances are the flow control between your
modem and your PC, or the flow control of
your service providers modems and systems is
not setup correctly.  This problem is very
difficult to diagnose and fix.  If you have
created your own DEFAULT.MOD script,
then recheck it and verify that the FlowControl
command matches the modem configuration
(hardware or software).  Refer to steps 3 and 4
of the DEFAULT.MOD section of this
appendix for more details.  If they match, it
may be a problem at your service provider.
Contact your Eudora technical support
representative for assistance in troubleshooting
this problem.

Mail can be retrieved via POP
but cannot be sent via SMTP.

Your telnet command probably ends with a
cr/lf combination (“\r\n”).  Remove the line
feed (“\n”) from the telnet command line.

Eudora times out after
sending or receiving mail (it
has never worked).

There is probably an error in your
DEFAULT.MID file and it may be waiting for
the wrong system prompt.  Verify that the
system prompt symbol in the “waitfor (system
prompt)” command matches your server
system prompt.  Also verify that it matches the
last line of the navigation sequence in your
DEFAULT.NAV file.

When sending mail, SMTP
complains that your HELO
command is invalid and must
be a fully qualified host.

Edit the EUDORA.INI file and add the line
SMTPHELOString=(your fully qualified host
name) in the [Dialup] section.
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Sympton Corrective Action

Eudora displays the following
error when you try to check
mail:

“Serial Overrun on Rx”

Serial overruns are usually caused by running
your modem at a speed greater then 9600 bps
when you don't have a 16550 UART in your
PC. The regular UART (8250) only has a one
byte buffer.  A serial overrun occurs when the
buffer is filled up and more bytes come in. The
16550 UART has a 16 byte buffer and should
never overrun.  It is also strongly
recommended to get a serial driver other than
the one that comes with Windows.  There are
several drivers on the internet which work
better at higher speeds. The Cybercom drivers
on ftp.qualcomm.com in the
quest/windows/utils directory work well. If
you do have a 16550 UART then the problem
could be your Windows com driver.

Eudora displays the following
error when you try to check
or send mail:

“Serial Framing Error”

This error indicates that flow control is not set
up correctly with your modem.  Hardware
flow control is recommended, and the
initialization strings sent to the modem in the
serial.mod file should set it up for hardware
flow control. Also put the modem into reliable
mode, using LAPM or MNP4 error correction.
If you are going to use software flow control
(Xon/Xoff), then it is only reliable up to 9600
bps. Also, for speeds over 9600, make sure the
the modem/serial port has a 16550 UART.
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Fine Tuning Dialup Eudora
Once you have successfully modified the default dialup files so that Eudora works with your system,
there are a couple of adjustments that can be made to fine tune Eudora for the best possible dialup
connection performance.  These are as follows:

1. Enable compression – Many modems allow for data to be compressed while traveling over
the phone line.  Enabling data compression can dramatically increase the speed at which
large messages are transmitted and received.  Data compression is available in MNP5 or
V.42 protocols.  To enable data compression, enter the appropriate command in the
DEFAULT.MOD file.  Typical Hayes commands which enable data compression are %C1,
%C3, and *DC1.  Check your modem reference manual for the command that applies to
your modem.

2. Delete the DEFAULT.END file – This file is required for systems that need help in
shutting down a modem.  If you have DTR configured correctly, then this file is not
required.  You will save approximately 5 seconds during shutdown if you delete this file.

EUDORA.INI [Dialup] Settings
The following settings can be entered into the [Dialup] section of the EUDORA.INI file (you will
have to create this section if it does not exist).  In general, the default parameters are what you want,
with the exception of “BaudRate,” which you may want to increase to at least twice the expected line
speed to get the best performance out of your modem.

Note: The EUDORA.INI [Dialup] settings can be modified in the dialup files by entering
the set command followed by the setting value (e.g., “set CRLFProcessing=0”).

ATSendDelay The delay between sending characters in a modem AT command (in
milliseconds).  The default is 100.

BaudRate Values support in this field; 2400, 9600, 19200, 38400, 56000.  The
default is 9600.

BreakTime Length of modem break command (in milliseconds).  The default is 150.

BusyRetries The number of times that the phone will be redialed after receiving a busy
signal.

ComPortName Sets port name “com1”, “com2”, ...  The default is com2.

CRLFProcessing Enabled by default, setting this to zero will inhibit the translation of \r\n to
\r on output and \r\r to \r on input.

DataBits 4 to 8 data bits.  8 bits is the default.

DialupTimeout The default dialup timeout is 60 seconds.  You may change the default
with this variable.  You may change the timeout during a script run with
the “timeout” command as well.

EndScript The name of the script file that closes the modem connection.

FlowControl Hardware or software.  Hardware is the default.

MiddleScript The name of the script file that closes the telnet connection.

ModemConfScript The name of the script file that does the modem configuration

Parity None, mark, even, odd.  None is the default.
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SMTPHELOString String to send as the parameter of the SMTP HELO command.  This
should only be set if your SMTP server fails to recognize HELO.

StartupScript The name of the file that does the dialup and navigation.

StopBits 1, 1.5, or 2.  1 is the default.

TelnetCommand Telnet command used to contact network servers (SMTP, POP, etc.).
Eudora’s default telnet command is:

TelnetCommand = telnet {system} {port}\r\n
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What Does MAPI Do?
Eudora’s MAPI support allows users to quickly attach documents to e-mail messages directly from
the application that created the document.  Without MAPI, users must first save the document,
remember what folder the document is in, switch to Eudora, and then remember to manually attach
the document to the outgoing message.

MAPI streamlines this process dramatically.  To e-mail the current, open document from your word
processor, select the Send command from your word processor’s File menu.  This automatically
activates Eudora and attaches a snapshot of the open document to a new composition message.

The MAPI system standardizes how messages are handled by client applications so that each client
application does not have to have custom code for each target messaging application.  MAPI
accomplishes this by providing a standard application program interface used by all MAPI-enabled
client applications.

An additional MAPI feature supported by Microsoft Office applications is the ability to add a
“routing slip” to a Word, Excel, or PowerPoint document.  This routing slip contains a list of e-mail
recipients obtained from the MAPI subsystem.  Once a document has an embedded routing slip, then
it can be semi-automatically routed as an attachment via e-mail to all recipients listed in the routing
slip.  Once the routing is complete, the annotated document is returned back to the original sender.
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MAPI Overview

Let’s start with a picture:

Eudora Pro

16-bit MAPI
client application

32-bit MAPI
client application

MAPI.DLL MAPI32.DLL

A MAPI client application is any 16-bit or 32-bit Windows application that knows how to access the
standard MAPI messaging functions in a library known as a DLL (Dynamic Link Library).  The
functions in the MAPI DLL allow a MAPI client application to transparently and generically access
a MAPI service provider.  A MAPI service provider is the application that handles the receipt,
transmission, and storage of messages.  Examples of MAPI client applications (“front-ends”) include
Microsoft Word and Microsoft Excel.  Examples of MAPI service providers (“back-ends”) include
Microsoft Mail, Microsoft Exchange, and Microsoft Fax.

All 16-bit client applications use the 16-bit MAPI.DLL and all 32-bit client applications use the 32-
bit MAPI32.DLL.  The MAPI and MAPI32 DLLs are “twins” which contain the same list of MAPI
functions—they are parallel implementations of the 16-bit and 32-bit MAPI functions.  These DLLs
are provided by Microsoft as standard components of Windows for Workgroups, Windows 95, and
Windows NT.  For non-networked Windows 3.x, the MAPI.DLL is available in add-on development
kits or is included with MAPI-enabled applications.  The MAPI DLLs are normally installed in the
Windows SYSTEM directory (or SYSTEM32 for Windows NT).

As shown in the diagram on the previous page, when a MAPI client application wishes to send a
document, it simply loads the appropriate MAPI library (DLL) and calls the defined MAPI
functions.  The MAPI DLL takes care of routing the messaging and authentication requests to the
appropriate MAPI service provider application, displaying the address book user interface, and
returning address book and messaging data to the MAPI client application.  The MAPI DLL also
provides an optional user interface for user authentication.  For example, the user may need to supply
a user name and password to the mail system in order to “log on” to the mail system. (The Eudora
implementation of MAPI does not implement authentication since Eudora itself requires
authentication to access the POP3 server.)
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Eudora Implementation of MAPI
Eudora implements a subset of the full MAPI library by providing two “replacement DLLs” for the
standard Microsoft MAPI DLLs.  The Eudora EUMAPI.DLL is a replacement for the 16-bit
Microsoft MAPI.DLL and the Eudora  EUMAPI32.DLL is a replacement for the 32-bit Microsoft
MAPI32.DLL.  The Eudora MAPI DLLs must be located in the same directory as the Eudora
program.

The Eudora MAPI DLLs implement the standard Simple MAPI functions detailed in the MAPI
specification.  The MAPI specification also defines Extended MAPI functions, however, the Eudora
MAPI DLLs implement only the Simple MAPI subset.

Note: The Eudora MAPI implementation requires all MAPI client applications to use only
the Simple MAPI functions supported by the Eudora MAPI DLLs.

MAPI client applications which use only the basic Simple MAPI calls will generally not be able to
tell the difference between the Eudora MAPI DLL functions and the Microsoft MAPI DLL
functions.

It is important to understand that MAPI client applications load the MAPI DLL libraries at runtime
whenever they need to access the MAPI functions.  Each client application expects to find either the
16-bit MAPI.DLL file or the 32-bit MAPI32.DLL file in a common, application-independent
location (generally the Windows SYSTEM directory).  Therefore, it is not sufficient to copy the
EUMAPI.DLL and EUMAPI32.DLL Eudora DLL files into the Windows SYSTEM directory
alongside the standard Microsoft MAPI.DLL and MAPI32.DLL files.  For client applications to find
the Eudora MAPI DLLs, the DLL files must be named MAPI.DLL and MAPI32.DLL.  This creates
a conflict since most Windows installations will have the MAPI.DLL and MAPI32.DLL files
preinstalled in the Windows SYSTEM directory to support Microsoft Mail (Windows for
Workgroups) or Microsoft Exchange (Windows 95, Windows NT).

Note: Eudora is able to swap the Eudora EUMAPI and EUMAPI32 DLLs with the
Microsoft MAPI and MAPI32 DLLs when the user launches Eudora , and is able to
unswap the Eudora MAPI DLLs when the user exits Eudora .

This approach gives the user the most flexibility and preserves the user’s ability to use Microsoft
Mail and/or Microsoft Exchange when Eudora is not running.  If we “permanently” install the
Eudora MAPI DLLs over the existing Microsoft MAPI DLLs, then applications (such as the
Microsoft Fax service bundled with Microsoft Exchange) which rely on the Microsoft MAPI DLLs
will no longer work.  This is clearly unacceptable for users who need to use MAPI for both
Microsoft Exchange and Eudora.
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Eudora MAPI Startup Procedure
When launched, Eudora runs the following “swap” procedure when the user has selected either the
“Always” or the “When Eudora is running” MAPI Server option in Eudora (see Tools / Options /
MAPI):

1. Check to see whether or not the Eudora MAPI DLLs are already installed in the Windows
SYSTEM directory.  If so, then finish.

2. Check for existing Microsoft MAPI.DLL and MAPI32.DLL files.  If found, rename MAPI.DLL
to MAPI.000 and rename MAPI32.DLL to MAPI32.000. (If a MAPI.000 file already exists, then
Eudora uses MAPI.001, MAPI.002 etc.)

3. Copy the EUMAPI.DLL and EUMAPI32.DLL files from the Eudora program directory to the
Windows SYSTEM directory as MAPI.DLL and MAPI32.DLL, respectively.

Eudora MAPI Shutdown Procedure
When shutdown, Eudora runs the following “unswap” procedure when the user selects either the
“When Eudora is running” or “Never” MAPI Server option in Eudora (see Tools / Options / MAPI):

1. Check to see whether or not the Eudora MAPI DLLs are already installed in the Windows
SYSTEM directory.  If not, then finish.

2. Delete the Eudora MAPI.DLL and MAPI32.DLL files.

3. Rename the MAPI.000 and MAPI32.000 files, if any, to MAPI.DLL and MAPI32.DLL,
respectively. (If a MAPI.001, MAPI.002 etc file exists, then Eudora renames the one with the
highest number.)
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Eudora DLL Swapping Restrictions

It is important to note that there are several restrictions with the above Eudora swap and unswap
procedures: The Eudora swap and unswap procedures can only run successfully if the MAPI.DLL
and MAPI32.DLL are not currently “in use” by one or more MAPI client applications.

When a MAPI client application loads a MAPI or MAPI32 DLL file, Windows “locks” the DLL file
while the library is loaded into memory to show that the file is “in use.”  Eudora can normally detect
that the MAPI.DLL and/or MAPI32.DLL files are “in use.”  If Eudora detects that a MAPI or
MAPI32 DLL is locked, it displays an error message and skips the swap or unswap procedure.

When Eudora is forced to skip the swap or unswap procedure, this means that the MAPI DLLs are in
the wrong “state” with respect to Eudora -- that is, 1) the Microsoft MAPI DLLs could be installed
even after Eudora starts, or 2) the Eudora MAPI DLLs could be installed even after Eudora shuts
down.  To prevent this from happening, use the following procedure when using Eudora MAPI:

1. Start Windows.

2. Start Eudora.

3. Start any MAPI client applications.

4. Send attachments to Eudora via the installed Eudora MAPI interface.

5. Shutdown all MAPI client applications.

6. Shutdown Eudora.

7. Exit Windows.

Once Eudora’s MAPI DLLs get into the wrong “state” with respect to Eudora, you cannot correct the
state mismatch until all MAPI client applications unload the MAPI DLLs and Windows is able to
unlock the DLL file.  Since the MAPI DLLs are shared by multiple MAPI client applications,
Windows does not unlock the MAPI DLL file until the last MAPI client application is shut down.
Therefore, to force all MAPI client applications to unload the DLLs, you must shutdown all MAPI
client applications.

Important:When running 16-bit MAPI client applications under Windows 3.1 or Windows NT,
then Eudora cannot detect the lock placed on the MAPI DLLs by Windows unless the SHARE
program is running.  This means that Eudora can inadvertently perform the DLL swap and/or
unswap procedures while the MAPI DLL is loaded into memory.  This almost always causes
Windows to become unstable and can lead to crashes in MAPI client applications as well as in
Windows itself.

Note: If you run 16-bit MAPI client applications under Windows 3.1 or Windows NT, then
you should always run the SHARE program.

The good news is that Windows for Workgroups and Windows 95 implement the SHARE
functionality without requiring you to explicitly run the SHARE program.  By default, Windows NT
only implements the SHARE functionality for 32-bit applications.  If you are running a 16-bit
application under Windows NT, then you must run the SHARE program explicitly as you do under
Windows 3.1.
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SMTP option 68 removing
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with multiple recipients 54creating using Mailbox menu 41

Main Toolbar 59Make if a folder option 41
Make Address Book entry command 55, 92moving in the 16-bit Mailboxes window

from a mailbox 55Move buttons 43
from Directory Services 55New command 41
from the Address Book 55
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Make it a Folder option 41, 42, 43 Quoted-printable encoding 103
Make Priority action 49 Types 104
Make Subject action 49 MIME encoding 23
Managing mail on the server Miscellaneous Options 87

Delete from server option 69 Allow Drag and Drop Transfers option 88
Delete from server when emptied from trash option 70 Close messages with mailbox option 87
Fetching 33 Empty Trash on Quit 45
Leave mail on server option 33, 69 Empty Trash when exiting option 87
Skip messages over ? K in size option 33 Intercept Netscape mailto URLs option 88
Skip messages over ? K option 69 Turbo redirect by default 36

Manual option 47 Turbo redirect by default option 88
Map Ctrl+R to “Reply to All” option 73 Modem selection 81
MAPI 61 Move buttons 43
MAPI options Multiple PCs

After sending messages, delete MAPI attachments field
85

checking mail from 33
Multiple recipients

Always use MAPI server field 85 creating a mailing list 53
Never delete MAPI attachments field 85 Multipurpose Internet Mail Extensions 103
Never use server field 85
When Eudora is running, use MAPI server field 85

NWhen messages are emptied from trash, delete MAPI
attachments field 85 Need RCPT (Recipient) 63

Match Case option 51 Network buffer size of ? bytes option 83
May use Quoted-Printable option 71 Network Open timeout after ? seconds option 83
Message Network timeout after ? seconds option 83

Deleting Never option 74
Unread/Queued 87 New button 47

Incoming New button in Address Book 53
Zooming windows 75 New command 16, 41, 46, 90, 92

Outgoing New mailbox dialog 16, 41, 46
Zooming window 75 New Message command 13, 19, 91

Message body New Message To submenu 56, 91
in incoming mail 31 New Text File command 89
in outgoing mail 13, 21 Next button 50

Message header Next command 50
in incoming mail 31 Next Mailbox button 51
in outgoing mail 20 Next Mailbox command 51

Message menu 91 Next Message button 50
Message Plugins Settings 60 Next Message command 50
Message Plugins Settings command 92 Next message, going to 87
Message Plugins submenu 90 Next time queued messages are sent option 26
Message summaries 39 Nicknames 53

Attachments column 40 adding to the Quick Recipient List 54
changing the subject of 32 creating in the Address Book 53
Date column 40 None action 49
Priority column 40 not option 48
resizing columns 41 Notification
selecting 39 Generate Filter Report option 79
Sender/Recipient column 40 Open mailbox option 79
Size column 40 Play a sound option 79
Status column 40 Use an alert option 79
Subject column 40

Message Window Height setting 75
OMessage Window Width setting 75

MIME 103 On or After option 26
Base64 encoding 103 Online Help 11
Content-type header 104 Open Attachment command 89
Macintosh creators 104 Open Eudora 10
Macintosh types 104 Open mailbox option 30, 79
Mapping 104 Open Text file command 89
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Options Plugins 60
Advanced Network 83 POP 10
Dialup 81 POP account option 10, 66, 67, 68, 69
Kerberos 86 POP server 29, 33, 97, 101
MAPI 85 UNIX 97
Styled Text 77 VAX/VMS 97

Options command 65, 93 VM/CMS 97
or option 48 POP version 3 101
Out command 90, 92 Popper 97
Out mailbox 26, 45 Post Office Protocol 10
Outgoing message window Print

Message body 21 current item 60
Message header 20 Print command 60, 89

Attachments field 21 Print Preview command 89
Bcc field 21 Print Setup command 89
Cc field 21 Print... command
From field 20 Font options 75
Subject field 20 printing with strange line breaks 64
To field 20 Priority column 40

Title Bar 19 Priority Popup
Toolbar 19 default for replies 22

Attachment Type popup 20 in incoming mail 31
Keep Copy button 20 in outgoing mail 19
Priority popup 19 levels 22
Queue button 20 Progress window 14
Quoted-Printable button 20 Put it on the recipient list option 54
Send button 20 Put original To recipients in Cc field option 35
Signature popup 19 Put text attachments in body of message option 74
Text As Document button 20
Word Wrap button 20

QOutgoing option 47
Q, in the Status column 25, 26, 40
Queue a message bigger than ? k option 80P
Queue a message with no subject option 80

Parity field 82 Queue button 20, 25
Password Queue For Delivery command 91

changing 30 Queue mail 25
server source code for 97 Change Queueing command 26

check when sending mail 64 Change Queueing dialog 25, 26
entering 14, 29 Don’t Send option 26
forgetting 30 editing before sending 26
remembering 30 for a certain time 26
Saving 30, 69 Immediate send option 25

Passwords option 70 Next time queued messages are sent option 26
Paste as Quotation command 90 On or after option 26
Paste command 90 Queue button 25
Pencil button 31 Queue Message command 25
Personal Info Options 67 Right Now option 26

Dialup username option 67 Send message Right Now option 25
POP account option 67 Send Queued Messages command 25
Real name option 67 sending queued mail when checking mail 26
Return address option 67 taking mail out of the queue 26

Ph Queue Message command 25
button 57 Queued (Q) status 25
command 57 Quick Recipient List
option 68 Adding email address to 56
server source code 97 Forward To submenu 56

Ph button 57 Insert Recipient command 56
Phone number field 81 New Message To submenu 56
Play a sound option 30, 79 putting nicknames in 54
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Recipient List option 56 Requirements 9
Redirect To submenu 56 Return address option 67, 71

Quit command 11 Return key 31
Empty Trash when exiting option 87 RFCs 102

Quit with messages queued to be sent option 80 Right Now option 26
Quoted text

in replies 35
Swith styles in replies 35

Quoted-printable S, in the Status column 27, 40
Turning off 104 Save As command 51, 89

Quoted-Printable button 20 Save command 14, 24, 54, 89
Save mail as text

as a single file 52R
Guess Paragraphs option 52

R, in the Status column 35, 40 Include Headers option 52
Real name option 10, 66, 67 Save password option 30, 69, 84
Recipient List option 54, 56 Saved (•) status 14, 24, 26
Redirect Say OK to alerts after ? seconds option 87

automatically put new message in the queue 36 Select All command 90
Redirect command 36 Send Again command 37, 91
Turbo redirect by default option 36, 88 Send button 14, 20, 25

Redirect command 36, 91 Send button. The .i.Change Queueing dialog 25
Redirect To submenu 56, 91 Send Immediately command 25, 91
Redirected (D)redirectedus 36 Send mail
Register Eudora 94 all at once 25
Registration 11 at a certain time 26
Rejected mail 37 Change Queueing dialog 25
Remove All button 43 Default signature option 72
Remove button 43 Immediate send option 25, 71
Remove It button 43 keeping copies 72
Remove Recipient command 92 May use Quoted-Printable option 71
Remove This Menu 94 replies 35
Rename 43 Send button 25
Rename button 42 Send Immediately command 25
Renaming a mail folder 42, 43 Send message Right Now option 25
Renaming a mailbox 42, 43 Send on check option 69, 71
Replied (R) status 35 Send Queued Messages command 25
Reply sending queued mail when checking mail 26

Copy original’s priority to reply option 35 Tabs in body of message option 72
map Ctrl-R to Reply to All 35 with a password 64
Put original To recipients in Cc field option 35 Send message Right Now option 25
quoting original text 35 Send on check option 26, 69, 71
Reply command 35 Send Queued Messages command 25, 89

Reply command 35, 91 Send to Back 93
Reply To All command 35, 91 Sender/Recipient column 40
Reply-To field in filters 48 Sending Mail Options 71
ReplyInclude yourself option 35 Default signature option 72
Replying Domain to add to unqualified names option 71

Copy original’s priority to reply option 73 Immediate send 25
Map Ctrl+R to “Reply to All” option 73 Immediate send option 71
When replying to all option 73 Keep copies of outgoing mail 27

Replying Options 73 Keep copies option 72
Copy original’s priority to reply 22, 35, 73 May use Quoted-Printable option 71
Include yourself 35 Return address option 71
Map Ctrl+R to “Reply to All” option 73 Send on check 26
Put original To recipients in Cc field 35 Send on check option 71
When replying to all option 73 SMTP server option 71

Request More Info 94 Tabs in body of message option 72
Request Ordering Program 94 Word wrap option 71
Require confirmation for delete option 87 Sent (S) status 27
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Server button 57 Text As Document button 20
Service provider selection 82 Tile Horizontal 93
Set a changed message back to read-only option 80 Tile Vertical 93
Sharing a PC 61 Timed (T) status 26
Show category icons option 76 Title Bar
Show columns options 78 for incoming mail 31
Show status bar option 76 for outgoing mail 19
Show toolbar option 75 To button
Show toolbar tips option 76 in the Address Book 55
Show trace window option 82 To field
Signature popup 19 in a reply 35
Signatures in Filters 48

creating or modifying 21 in outgoing mail 13, 20
including in a message 22 Toolbar

Signatures submenu 93 in incoming mail 31
Simple Mail Transfer Protocol 10, 101 in outgoing mail 19
Size column 40 Tabs in Body 20
Skip messages over ? K in size option 33 Tools menu 93
Skip messages over ? K option 69 Topics 94
Skip Rest action 49 Tow Truck icon 31
SMTP 10, 101, 102, 103 Transfer menu 92
SMTP server option 71 Transfer To action 49
Sort submenu 49, 90 Transferring mail to another mailbox
Sorting 49 and creating a mailbox or folder 46

in descending order 49 by dragging it 46
Space bar 31 by dragging the Tow Truck icon 46
Special menu 92 using the Transfer menu 46
Start Eudora and it’s not the default mailer option 80 Trash command 90, 92
starts with option 48 Trash mailbox 27, 45
Status Troubleshooting 63

-, never sent 40 Try to delete any unsent mail option 45
<blank>, read or unsendable 40 Try to delete queued mail option 45
D, redirected 36, 40 Try to delete unread mail option 45
F, forwarded 36, 40 Turbo redirect by default option 36, 88
Q, queued 25, 26, 40
R, replied 40

UR, replied to 35
S, sent 27, 40 Undo command 90
T, timed 26, 40 UNIX mail 95
•, saved or unread 14, 24, 26, 30, 40 unless option 48

Status column 40 Unload Winsock DLL after closing socket option 83
Stop bits field 82 Unmodified arrow keys option 87
Styled Text options 77 Unqualified name, adding domain 71
Subject column 40 Unread (•) status 30
Subject field URL

changing in message summaries 32 in incoming mail 33
in Filters 48 in outgoing mail 23
in incoming mail 31 Use an alert option 30, 79
in outgoing mail 13, 20 Use asynchronous Winsock calls for option 83

Summaries Only option 51 Use Directory button 32
Switch messages with options 87 Use signature option 72

Username option 84

T
VT, in the status column 26, 40

Tab key View By option 53
Switching fields with 20 View Mailboxes command 43, 93

Tabs in Body
Button in Toolbar 20

Tabs in body of message option 72
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W

Warnings
Delete queued mail option 80
Delete unread mail option 80
Delete unsent mail option 80
Empty the Trash mailbox option 80
Queue a message bigger than ? k option 80
Queue a message with no subject option 80
Quit with messages queued to be sent option 80
Set a changed message back to read-only option 80
Start Eudora and it’s not the default mailer 80
Try to delete any unsent mail option 45
Try to delete queued mail option 45
Try to delete unread mail option 45

When message emptied from Trash option 74
When receiving styles pay attention to option 77
When replying to all option 73
Window menu 93
Windows Sockets 97
Word Wrap button 20, 21
Word wrap option 71
Wrap Selection command 90
Wrapped text 20, 21

Y

You have new mail alert 15
You have no new mail alert 15

Z

Zoom windows when opening option 75
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